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About This Document 

Intended Audience 
1 Overview describes the functions, service features, and networking of the eSpace 7810, 

eSpace 7820, eSpace 7830, eSpace 7850, eSpace 7870, and eSpace 7803x. 

2 Single IP Phone Configuration describes how to configure an IP phone. 

3 Batch Configuration and Upgrade of IP Phones describes how to configure and upgrade IP 

phones in batches. 

4 Troubleshooting describes the troubleshooting of the eSpace IP phone. 

This document is intended for: 

 Technical support engineers 

 Maintenance engineers 

Change History 
Updates between document issues are cumulative. Therefore, the latest document issue 

contains all updates made in previous issues.  

Issue 01 (2011-12-31) 
First commercial release. 
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1 Overview 

1.1 Principle 
Huawei IP phones use the digitalized transmission technology in packets based on the IP 

technology. The basic principles are as follows: 

 Compress and encode voice data according to the voice compression algorithm. 

 Package the voice data based on a certain protocol such as the IP protocol.  

 Send data packets to the recipient through the IP network. 

 Decode and decompress voice packets after collecting the voice packets to restore the 

voice packets to the original voice signals. 

Voice data is transmitted through the IP network. The IP phone system converts the analog 

signals of a common phone into IP packets that can be transmitted through the Internet, and 

also converts the received IP packets to analog electric signals. 

1.2 Function Description 
In terms of the orientation, eSpace 7870, and 7850 are high-end-oriented products, eSpace 

7830 and 7820 are a middle-end-oriented product, and eSpace 7810 is a low-end-oriented 

product. eSpace 7870, 7850, 7830, 7820and 7810 are a series of products. 

In terms of the functions, eSpace 7870, 7850, 7830 and 7820 use the advanced digital signal 

processing (DSP) technology with the help of the automatic gain and comfort noise 

generation (CNG) technologies. Therefore, eSpace 7870 and 7830 provide voice of high 

quality, which is as good as the voice provided by the traditional public switched telephone 

network (PSTN). 

Codec Function 

eSpace 7850, 7830, 7820 and 7810 support G.711A, G.711µ, G.722, G.723, G.726, G.729AB, 

and iLBC codec mode, and configuration of voice codec priority. In general, retain the default 

configuration of voice codec priority for deployment. If the network environment is complex, 

you can adjust the codec priority according to the actual network bandwidth. 

 
eSpace 7870 supports G.711A, G.711µ, G.722, G.723, G.726, and G.729AB except iLBC. 
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If the network is in a good condition, G.711 is recommended, and the voice quality will be excellent. If 

the network is not in a good condition, G.729AB or G.723 is recommended. 

PoE Function 

eSpace 7870, 7850, 7830, 7820 and 7810 support the PoE function. When not being 

connected to a power adapter, a client can obtain power from a PSE device (a PoE switch 

such as the S3900) to work normally. eSpace 7870, 7850, 7830, 7820 and 7810 support the 

mode of free-line power supply and mode of signal-line power supply. When the PoE function 

is used, the reliable power supply distance is up to 100 meters. 

Bridging Function 

eSpace 7870, 7850, 7830, 7820 and 7810 support the bridging function. The device connected 

to the PC port of an IP phone can access the network connected to the LAN interface of the IP 

phone and can communicate with other devices in the network. In this case, the IP phone acts 

as a switch with two interfaces but the working mode is different from the working mode of a 

normal switch. Special configurations are performed at the lower layers of an IP phone to 

separate the broadcast packets between the two interfaces. Therefore, the IP phone is not 

affected by a large number of broadcast packets. 

DSP Functions 

The DSP chip of eSpace 7870, 7850, 7830, 7820 and 7810 supports comfort noise generation 

(CNG) and voice activity detection (VAD). These functions are controlled by the DSP 

automatically, which can be set on web pages. You can enable this function by selecting 

Enabled in Voice on the Phone page of the web configuration interface.  

VLAN Function 

eSpace 7870, 7850, 7830, 7820 and 7810 support the Virtual Local Area Network (VLAN) 

function. The packets sent by an IP phone are labeled with tags. This makes packets 

transmitted in a separate voice VLAN, and the stability of VoIP packets is ensured. 

QoS Functions 

The eSpace 78XX-series IP phones support the layer 2 quality of service (QoS) technology 

based on 802.1q and 802.1p and the layer 3 QoS technology based on ToS. The deployment 

of QoS on the VoIP bearer network ensures the voice quality during the transmission. 

PPPoE Function 

eSpace 7870, 7850, 7830, 7820 and 7810 support the PPP over Ethernet (PPPoE) dialing 

function. By using the preset PPPoE user name and password, an IP phone can initiate the 

PPPoE dialing and set up a connection with the softswitch through ADSL. This facilitates the 

setup of VoIP conversations. 

1.3 Network Introduction 
In terms of network features, eSpace 78XX-series IP phones can be deployed on enterprise 

networks to interoperate with application servers such as the IP PBX and UMS servers, 
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implementing functions such as the basic call services, additional services, unified messaging, 

and phone book display. This improves the enterprise communication efficiency. 

 

In the deployment of IP phones on the network with IPPBX, the original data networks of 

enterprises are used as the network that bears VOIP to deploy IP phones in distributed mode. 

With the help of the application servers, the functions such as the enterprise phone book 

function and voice message leaving function can be implemented. 
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2 Single IP Phone Configuration 

Configure and upgrade IP phones one by one if any of the following conditions is met: 

 There are only a few IP phones onsite. 

 The centralized upgrade environment is unavailable onsite. 

 Users require special services. 

This chapter describes how to configure a single IP phone. 

 
The methods for configuring eSpace 7870, 7850, 7830, 7820 and 7810 are similar. The configuration for 

eSpace 7850 is the most complex. This document describes how to configure eSpace 7850. Only eSpace 

7870, 7830, 7820 and 7810 configurations that are different from eSpace 7850 configurations are 
described. 

2.1 Quick Phone Configuration 

eSpace 7850 obtains an IP address by using Dynamic Host Configuration Protocol (DHCP) if 

there is a DHCP server onsite. By default, eSpace 78XX series obtain IP addresses through 

DHCP. When eSpace 7850 successfully obtains an IP address, press OK to view the IP 

address. 

If there is no DHCP server onsite, you need to use the keypad to set network parameters for 

eSpace 7850.  

The procedures for using the keypad to set the IP address, to configure the Session Initiation 

Protocol (SIP) server, and to set the SIP account are complex. Therefore, you are advised to 

set the IP address by using the keypad, and then access the web page to set other parameters.  

2.1.1 Using the Keypad to Set Network Parameters 

To use the keypad to set a static IP address, proceed as follows: 

1. Press Menu on the IP phone to access the main menu. 

 
For eSpace 7810, press MENU to access the main menu. 

2. Press 3. 

The Setting Type page is displayed. 
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For eSpace 7870, press 6 to access the Setting Type page. 

3. Press 2. 

The Please enter Password page is displayed. 

4. Enter the password (the initial password is admin). 

5. Press Confirm. 

The Advanced Settings page is displayed. 

6. Press 2. 

The Network page is displayed. 

7. Press 1. 

The WAN Port Option page is displayed. 

8. Press 2. 

The Static IP Client page is displayed. 

9. Press the up arrow key or down arrow key to select IP, press Del to delete the default IP 

address, and enter the required IP address. 

 
For eSpace 7810, press X to delete the default IP address. 

10. Set Subnet Mask, Default Gateway, Pri DNS, and Sec. DNS, and click Save. 

The WAN Port Option page is displayed. 

 
For eSpace 7810, press OK to save settings. 

11. Press Back to return to the Network page. 

 
For eSpace 7810, press MENU to return to the Network page. 

12. Press Back. 

The following messages are displayed: 

Network updating  

Please wait…  

 

The settings take effect after the IP phone is restarted. 

 
For eSpace 7810 and 7820, the following messages are displayed: 

Network updating  

Please wait…  

 

Then the following messages are displayed: 

Initializing  

Please wait…  

 

2.1.2 Configuring an IP Phone on Web Pages 

Open the Internet Explorer, enter the IP address of an IP phone in the address box, and set 

parameters for the IP phone on the web configuration page that is displayed. 

The web configuration page consists of the following tabs: 
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 Status: Set the network status, firmware version, MAC address, and other information 

on this tab page. 

 Account: Set IP phone's SIP account parameters on this tab page. eSpace 7870 and 7850 

supports a maximum of six accounts, eSpace 7830 and 7820 supports a maximum of 

three accounts, and eSpace 7810 supports a maximum of two accounts.  

 Network: Set basic network parameters (such as the WAN port and LAN port) and 

advanced network parameters (such as LLDP, VLAN) on this tab page. 

 Phone: Set the language, time, call forwarding, do-not-disturb (DND), hold, transfer, and 

other functions, and set the DSS keys, voice, ring tone, signal tone, and dialing rules. For 

eSpace 7850 and 7830, the soft key layout, keys on an expansion module, and short 

messages can also be configured on this tab page. 

 DSS Key: Set DSS keys on this tab page. This tab page is available only to eSpace 7870. 

The DSS keys of other IP phones are configured on the Phone tab page. 

 Contacts: Set the local phone book, blacklist, number dialing on web pages, remote 

phone book, and LDAP. The remote phone book and Lightweight Directory Access 

Protocol (LDAP) address book are supported only by eSpace 7870, 7850, 7830 and 

7820. 

 Upgrade: Set TR069 parameters for manual upgrade and automatic upgrade. 

 Security: Change the password of an administrator or a common user, and upload the 

trust certificates to the TLS/SSL client and server. 

Accessing the Web Configuration Page 

Before accessing the web configuration page, connect the IP phone and computer to the same 

hub or switch. If there is no hub or switch, connect the computer to the PC port of the IP 

phone. 

To access the web configuration page, proceed as follows: 

1. Start the web browser. 

2. To view the IP address of the IP phone, press the OK key when the phone is connected 

to the network. 

3. Enter an IP phone's IP address in the address box, and press Enter. 

The IP address is in the format xxx.xxx.xxx.xxx, in which xxx ranges from 0 to 255. For 

example, 10.10.10.1. 

4. Enter admin in the User name text box, and enter the administrator password (default: 

admin) in the Password text box. Then click OK, as shown in Figure 2-1. 
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Figure 2-1 Login dialog box 

 

 

Viewing the IP Phone Status 

After logging in to the IP phone's web page, click the Status tab and view the IP phone status, 

as shown in Figure 2-2. 
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Figure 2-2 Status tab page 

 

 

Table 2-1 lists the parameters on the Status tab page. 

Table 2-1 Parameters on the Status tab page 

Parameter Description 

Firmware Version Firmware version number, which is used to check the upgrade result. 

Hardware Version Hardware version number, which is used to identify hardware. 

WAN Port Type Method of obtaining eSpace 7850 IP address. 

WAN IP Address IP address of an IP phone. 

Subnet Mask Subnet mask of an IP phone. 

MAC Address MAC address of an IP phone, which is a hexadecimal number. MAC 

addresses are important for configuring IP phones in batches. 

Link Status Connection status of the WAN port. 

PC IP Address IP address of the PC port. 

Device Type Connection type of the PC port. 

DHCP Server 

Status(PC) 

Status of the DHCP server connecting to the LAN port. 

 

Setting Basic Parameters for a SIP Account 

eSpace 7870, 7850, 7830, 7820 and 7810 provide six lines, six lines, three lines, three lines 

and two lines respectively. Each line can be configured with a SIP account. 
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The following procedure configures a SIP account. 

1. Click the Account tab. On the Account tab page, select Account 1 from the Account 

drop-down list box, and set SIP parameters, as shown in Setting basic parameters .  

Setting codec parameters shows the Codecs area for setting the voice coding types for 

SIP accounts. 

2. In the Basic area, select On for Account Active, and set User Name and Register 

Name. Set the SIP server IP address and port number for SIP Server. 

 
The Label and Display Name parameters are optional. Unless otherwise specified, retain the default 

value for optional parameters. 

If authentication information is configured on the SIP server, enter the authentication password in the 

Password text box. 

If the outbound proxy server is required, select Enabled from the Enable Outbound Proxy Server 
drop-down list box, and enter the server IP address and port number provided by the carrier in the 

Outbound Proxy Server and the corresponding Port text box. 

3. Set voice coding types in the Codecs area. 

4. Click Confirm. 

Settings are saved, and the IP phone starts to register the account. 

After the web page is refreshed, you can check the registration status of the account in 

the Register Status area. 

After the preceding operations are performed, the IP phone can make or answer calls. For 

details about parameters, see Parameters for setting a SIP account, Parameters in the Codecs 

area, and Parameters in the Advanced area. 

2.2 Account Configuration 

2.2.1 Setting Basic Parameters 

Set basic parameters in the Basic area on the Account tab page, as shown in Figure 2-3. 
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Figure 2-3 Setting basic parameters 

 

 

Table 2-2 lists the parameters in the Basic area on the Account tab page. 

Table 2-2 Parameters for setting a SIP account 

Parameter Description 

Register Status Status of the selected account. Options are Registered, Unregistered, 

Registering, and Register failed. 

Account Active Indicates whether to activate the account.  

Default value: Off 

Label Label displayed on the LCD when the IP phone is in the standby 

state, for example, Line1. 

Display Name Account name displayed on the called party's phone LCD when the IP 

phone functions as a calling party. This function requires the SIP 
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Parameter Description 

server. 

Register Name Authentication ID. 

User Name User name provided by the VoIP service provider. The value is 

similar to a phone number or is an actual phone number. 

Password Password corresponding to Register Name. The value is provided by 

the service provider. 

SIP Server SIP server's IP address or domain name, which is provided by the 

VoIP service provider. 

Port Port number of the SIP server.  

Default value: 5060 

Enable Outbound 

Proxy Server 

Indicates whether to enable the outbound proxy server. It is used for 

the firewall or NAT penetration in different network environments. If 

the system detects that the symmetric NAT and STUN cannot work, 

only the outbound proxy server can provide solution for symmetric 

NAT. 

Outbound Proxy 

Server 

IP address or domain name of outbound proxy server, media gateway, 

or session border controller. 

Port Port number of the outbound proxy server. 

Default value: 5060 

Transport The options are UDP, TCP, TLS, and DNS-SRV. The values UDP, 

TCP, and TLS are SIP transmission methods, in which TLS indicates 

encrypted transmission. The value DNS-SRV indicates that an IP 

phone determines the transfer type (UDP, TCP, or TLS) based on the 

information in the DNS SRV record sent by the server. 

Backup Outbound 

Proxy Server 

Standby proxy server, which starts to work when the outbound proxy 

server fails. 

Port Port number of the standby outbound proxy server. 

Default value: 5060 

NAT Traversal Indicates whether to enable NAT traversal. 

If this parameter is set to STUN, eSpace 7850 decides whether to 

enable NAT traversal based on the STUN client configurations. In 

this mode, the STUN client built-in eSpace 7810 communicates with 

a specified STUN server to check firewalls or NAT and their types. If 

the NAT is the Full Cone, Restricted Cone, or Port-Restricted Cone 

mode, eSpace 7810 attempts to use the public IP address and port 

number to send all SIP and Service Data Point (SDP) information.  

STUN Server IP address or domain name of the STUN server. 

Port Port number of the STUN server. 

Default value: 3478 

Voice Mail Voice mailbox access code. After setting this parameter, you can 
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Parameter Description 

press the Message indicator to connect to the voice mailbox server.  

Proxy Require Parameter for the Nortel platform. If IP phones register with the 

Nortel platform, this parameter is mandatory. The parameter value is 

fixed at com.nortelnetworks.firewall. If the parameter value is 

incorrect, contact Nortel for help. 

Missed call log Indicates whether to record missed calls. If you select Disabled, an IP 

phone does not record missed calls. 

Auto Answer Indicates whether to enable the auto answer function. If the function 

is enabled, calls to the account are answered automatically. 

Ring Type Ring tone for the account. 

 

2.2.2 Setting Codec Parameters 

Set codec parameters in the Codecs area on the Account tab page, as shown in Figure 2-4. 

Figure 2-4 Setting codec parameters 

 

 

Table 2-3 lists the parameters in the Codecs area on the Account tab page. 

Table 2-3 Parameters in the Codecs area 

Parameter Description 

Disable codecs Disabled voice coding types. eSpace 7850 supports the following 

coding types: PCMU/PCMA (also called G.711 (a/μ)), G726-16k, 
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Parameter Description 

G726-24k, G726-32k, G726-40k, G.723.1, G.729AB, G.722, and 

iLBC. 

Enable codecs Enabled voice coding types. The types are listed in descending order 

of priority. 

 

2.2.3 Setting Advanced Parameters 

Set advanced parameters in the Advanced area on the Account tab page, as shown in Figure 

2-5. 

Figure 2-5 Setting advanced parameters 
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Table 2-4 lists the parameters in the Advanced area on the Account tab page. 

Table 2-4 Parameters in the Advanced area 

Parameter Description 

UDP Keep-alive Message Indicates whether to send a UDP message at an 

interval to keep a port always available.  

UDP Keep-alive Interval(seconds) Interval for sending UDP messages. For example, 30 

seconds. 

Login Expire(seconds) If a user does not perform any operations within the 

period specified by this parameter, logs the user out. 

Unit: second 

Default value: 3600 

Local SIP Port Port for the SIP server to communicate with eSpace 

7850. 

Default value: 5060 

RPort Port through which the server sends a response to 

eSpace 7850. Details about this parameter are 

specified in RFC 3581. 

SIP Session Timer(seconds) T1 Round trip time (RTT) between the server and the 

client. If the network latency is long, set it to a larger 

value. Details about RTT are specified in RFC 3261. 

Default value: 0.5 

SIP Session Timer(seconds) T2 Interval between the INVITE response receiving and 

the non-INVITE request sending, in seconds. Details 

about this parameter are specified in RFC 3261. 

Default value: 4 

SIP Session Timer(seconds) T4 Duration for sending information between the client 

and the server. Details about this parameter are 

specified in RFC 3261. 

Default value: 5 

Subscribe Period(seconds) Validity period for busy lamp field (BLF) 

subscription. 

Default value: 1800 

DTMF Type DTMF signal transmission type. The options are as 

follows:  

 INBAND: DTMF signals are sent as voice 

signals.  

 RFC2833: DTMF signals are transmitted based 

on Real-time Transport Protocol (RTP). The 

header in an RTP packet indicates transmission of 

DTMF signals and defines the DTMF signals. 

 SIP INFO: DTMF signals are transmitted in SIP 

INFO messages. The main defect is that DTMF 
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Parameter Description 

signals may not be transmitted at the same time 

with media packets because SIP control signaling 

and media packets are sent separately. 

 AUTO+SIP INFO: The DTMF signal 

transmission type is determined by negotiation. 

The type can be INBAND or RFC2833. 

Default value: RFC2833 

How to INFO DTMF Method for using SIP INFO to transmit DTMF 

signals.  

DTMF Payload (Scope: 96~255) Payload for using RFC 2833 to transmit DTMF 

signals. 

Value range: 96 to 255 

Default value: 101 

100 reliable retransmission Indicates whether to enable the PRACK function to 

make the temporary SIP response (1xx signaling) 

more reliable. The PRACK function must be enabled 

for the PSTN network. 

Enable Precondition The value Enabled indicates that resources are 

reserved. Details about this parameter are specified in 

RFC 3262. 

Subscribe Register Indicates whether to enable the subscription function 

for registration. This parameter is used to monitor 

account registration when the IP Multimedia 

Subsystem (IMS) system is involved. 

Subscribe for MWI Indicates whether to subscribe to the MWI service. 

The value Enabled indicates that the IP phone 

periodically sends subscription information to the 

server to update the MWI status.  

MWI Subscription Period(Scope: 

0~84600)(seconds) 

Validity period for the MWI service. 

Default value: 3600 

Caller ID Header The options are FROM and PAI. FROM: The 

calling number displayed on the called phone is 

obtained from the FROM header. 

PAI: The calling number displayed on the called 

phone is obtained from the PAI header. 

Use Session Timer Indicates whether to update sessions as scheduled. 

The IP phone periodically sends a re-INVITE request 

to hold a session. The server uses the re-INVITE 

request to monitor the session status. Details about 

this parameter are specified in RFC 4028. 

Session Timer(seconds) Interval for updating sessions. 

Refresher Party who updates sessions. The value Uac indicates 

that the client updates sessions, and the value Uas 
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Parameter Description 

indicates that the server updates sessions. 

Use user=phone The value Enabled indicates that the user=phone 

flag is added to the SIP URIS header, identifying 

non-phone devices, for example, a gateway. 

Voice Encryption(SRTP) Secure RTP packet transfer. 

ptime(ms) Interval for transferring RTP packets. 

Shared Line Indicates whether to enable the shared line function. 

Dialog-Info Call Pickup Indicates whether to enable the Dialog-Info Call 

Pickup function. If this function is enabled, a DSS 

key can be assigned the call pickup function without a 

function code. 

SIP Registration Retry 

Timer(Scope:0~1800)(seconds) 

Interval between IP phone registration attempts. 

 

2.3 Network Configuration 

2.3.1 Configuring Network Ports 

Set network port parameters in the Internet Port(WAN) area on the Network tab page, as 

shown in Figure 2-6. 

To configure the network port for eSpace 7870, click the Network tab and click Basic. 

Figure 2-6 Setting network port parameters 
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Table 2-5 lists the network port parameters. 

Table 2-5 Network port parameters 

Parameter Description 

DHCP If this option is selected, eSpace 7850 automatically connects 

to the DHCP server for obtaining resources such as the IP 

address, subnet mask, gateway, and DNS server information. 

Static IP Address If this option is selected, you must set network parameters 

including IP Address, Subnet Mask, Default Gateway, 

Primary DNS, and Secondary DNS. For details about these 

parameters, contact the network administrator. 

PPPoE If an xDSL modem is used, PPPoE can be used to connect an 

IP phone to the network. If this option is selected, you must 

set User and Password. For details about these parameters, 

contact the network service provider. 

 

2.3.2 Configuring PC Ports 

When the network port on a PC connects to the PC port on an IP phone, the phone functions 

as a network bridge or a router. 

Set PC port parameters in the PC Port area on the Network tab page, as shown in Figure 2-7. 

To configure the PC port for eSpace 7870, click the Network tab and click Basic. 

Figure 2-7 Setting PC port parameters 

 

 

Table 2-6 lists the PC port parameters. 
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Table 2-6 PC port parameters 

Parameter Description 

As Bridge If you select As Bridge, the PC port functions as a bridge. 

As Router If you select As Router, eSpace 7850 functions as a router. 

-IP Address IP address of an IP phone when it functions as a router. 

-Subnet Mask Subnet mask for the IP address of an IP phone when it 

functions as a router. 

-Enable DHCP Server Indicates whether to enable the DHCP function for eSpace 

7850. 

-Start IP Address Start IP address assigned to the device connected to the PC 

port when the DHCP function is enabled for eSpace 7850. 

-End IP Address End IP address assigned to the device connected to the PC 

port when the DHCP function is enabled for eSpace 7850. 

 

2.3.3 Enabling the VLAN Function 

Function Description 

A VLAN is a group of hosts with a common set of requirements that communicate as if they 

were attached to the same broadcast domain, regardless of their physical location. VLANs are 

mainly configured on switches and routes. Broadcast traffic and unicast traffic on a VLAN 

cannot be forwarded to other VLANs, which controls traffic, simplifies network management, 

and reduces broadcasts.  

If the VLAN function is enabled on an IP phone, the IP phone can communicate only with 

computers on the same VLAN. 

Phone Configuration 

Set VLAN parameters in the Advanced area on the Network tab page, as shown in Figure 

2-8. 
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Figure 2-8 Setting VLAN parameters 

 

 

The VLAN function can be enabled for both the network port and PC port. Table 2-7 lists the 

VLAN parameters. 
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Table 2-7 VLAN parameters 

Parameter Description 

WAN Port Set VLAN parameters on the network port. 

-Active The value Enabled indicates that the VLAN function is 

enabled for the network port. 

-VID ID of the VLAN where the IP phone belongs to. 

The network administrator divides the network where the 

switch resides into multiple VLANs. Each VLAN has a 

unique ID. 

-USPRIORITY VLAN priority for the network port. The value ranges from 0 

to 7. 

PC Port Set VLAN parameters on the PC port. 

-Active The value Enabled indicates that the VLAN function is 

enabled for the PC port. 

-VID ID of the VLAN where the IP phone belongs to. 

The network administrator divides the network where the 

switch resides into multiple VLANs. Each VLAN has a 

unique ID. 

-USPRIORITY VLAN priority for the PC port. The value ranges from 0 to 7.  

 

Configuration File 

Table 2-8 eSpace 7850, 7830, 7820 and 7810 parameters in the VLAN configuration file 

Section 

Header and 
Path Parameters 

Value 
Range Description 

[ VLAN ] 

path = 

/config/Network/

Network.cfg 

ISVLAN 0 or 1 Indicates whether to enable 

the VLAN function on the 

network port. 

 0: no 

 1: yes 

Default value: 0 

VID 0 to 4094 VLAN ID for the network 

port. 

Default value: 0 

USRPRIORITY 0 to 7 VLAN priority for the 

network port. 

Default value: 0 

PC_PORT_VLAN_ENAB 0 or 1 Indicates whether to enable 

the VLAN function on the 
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Section 

Header and 
Path Parameters 

Value 

Range Description 

LE PC port.  

 0: no 

 1: yes 

Default value: 0 

PC_PORT_VID 0 to 4094 VLAN ID on the PC port. 

Default value: 0 

PC_PORT_PRIORITY 0 to 7 VLAN priority for the PC 

port. 

Default value: 0 

 

Table 2-9 eSpace 7870 parameters in the VLAN configuration file 

Section Header 

and Path Parameters Value Range Description 

[cfg:/phone/confi

g/system.ini,rebo

ot=1] 

VLAN.ISVLAN 0 or 1 Indicates whether to 

enable the VLAN 

function on the 

network port. 

 0: no 

 1: yes 

Default value: 0 

VLAN.VID 0 to 4094 VLAN ID for the 

network port. 

Default value: 0 

VLAN.USRPRIO

RITY 

0 to 7 VLAN priority for the 

network port. 

Default value: 0 

VLAN.PC_PORT

_VLAN_ENABL

E = 1 

0 or 1 Indicates whether to 

enable the VLAN 

function on the PC 

port.  

 0: no 

 1: yes 

Default value: 0 

VLAN.PC_PORT

_VID 

0 to 4094 VLAN ID on the PC 

port. 

Default value: 0 

VLAN.PC_PORT 0 to 7 VLAN priority for the 
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Section Header 

and Path Parameters Value Range Description 

_PRIORITY PC port. 

Default value: 0 

 

2.3.4 Enabling the LLDP Function 

Function Description 

Link Layer Discovery Protocol (LLDP) organizes local device information into 

type-length-value (TLV) and encapsulates the information into Link Layer Discovery Protocol 

Data Unit (LLDPDU). LLDP sends LLDPDU to directly-connected neighbors and saves 

LLDPDU from neighbors in Management Information Base (MIB). LLDP enables a device to 

store and manage information about the device itself and directly-connected neighbors for the 

network management system to check the link communication status. 

LLDP is used on the VoIP terminals in the following scenarios: 

 LLDP packet receiving 

After an administrator configures LLDP broadcast information such as VLAN ID and 

QoS on a switch that supports LLDP, an IP phone automatically updates network 

information such as VLAN ID and QoS based on the received LLDP information after 

being powered on. 

Every time an IP phone moves on a network or a new VLAN is assigned to the switch 

port, the IP phone automatically checks its home VLAN and modifies local VLAN 

settings. 

 LLDP packet sending 

Emergency call: LLDP information contains address information. When an emergency 

occurs, the position is quickly located based on the address information. 

System maintenance: LLDP provides accurate network mapping, traffic data, and other 

information for administrators to locate network faults. 

Function Implementation 

Figure 2-9 shows the flowchart for implementing LLDP. 
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Figure 2-9 Flowchart for implementing LLDP 

 

 

After power-on, an IP phone updates the VLAN and QoS information by: 

 Sending an LLDP packet 

If the LLDP function is enabled for an IP phone, the IP phone sends the switch an LLDP 

packet that contains local network information in multicast mode at an interval.  

 Receiving an LLDP packet 

When an IP phone receives an LLDP packet from a server on the network and finds that 

the local VLAN ID is different from the VLAN ID in the packet or that the local VLAN 

is disabled, the IP phone updates the local VLAN information based on that in the packet. 

If the IP phone finds that the QoS in the packet is different from the local setting, the IP 

phone updates the local QoS setting. 
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Phone Configuration 

Set LLDP parameters in the Advanced area on the Network tab page, as shown in Figure 

2-10. 

Figure 2-10 Setting LLDP parameters 

 

 

Table 2-10 lists the LLDP parameters. 

Table 2-10 Description of LLDP parameters 

Parameter Description 

Active Indicates whether to enable the LLDP function.  

Packet 

Interval(Scope:1

~3600s) 

Interval for sending an LLDP packet. 

Default value: 120 

 

Configuration File 

Table 2-11 eSpace 7850, 7830, 7820 and 7810 parameters in the LLDP configuration file 

Section Header and Path Parameters 
Value 
Range Description 

[LLDP ] 

path = 

/config/Network/Network.cfg 

EnableLLDP 0 or 1 Indicates whether to 

enable the LLDP 

function.  

 0: no 

 1: yes 

Default value: 0 

PacketInterval 1 to 3600 Interval for sending 

LLDP packets, in 

seconds. 
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Section Header and Path Parameters 
Value 

Range Description 

Default value: 120 

 

Table 2-12 eSpace 7870 parameters in the LLDP configuration file 

Section 
Header and 
Path Parameters Value Range Description 

[cfg: 

/phone/config

/system.ini,re

boot=1] 

LLDP.EnableLLDP 0 or 1 Indicates whether to 

enable the LLDP 

function. 

 0: no 

 1: yes 

Default value: 0 

LLDP.PacketInterva

l 

1 to 3600 Interval for sending 

LLDP packets, in 

seconds. 

Default value: 120 

 

2.3.5 Enabling the 802.1x Authentication 

Function Description 

802.1x is a protocol for port-based network access control. It provides an authentication 

mechanism to devices that attempt to connect to a LAN. 

 If a device is authenticated, the device can access resources on the LAN. 

 If a device fails the authentication, the device cannot access resources on the LAN.  

 
eSpace 7870 does not support the 802.1x authentication. 

An 802.1x system works in Client/Server mode, as shown in Figure 2-11. The 802.1x 

authentication involves three parties: a client, a device, and an authentication server.  

Figure 2-11 Three parties involved in 802.1x authentication 
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A device provides ports for clients to access a LAN. The ports support the following access 

control modes: 

 Authorized-force: A port in this mode allows clients to access network resources without 

authenticating the clients. 

 Unauthorized-force: The device does not authenticate clients accessed through a port in 

this mode. 

 Auto: A port in this mode allows clients to send and receive packets but does not allow 

clients to access network resources before authentication succeeds. If authentication 

succeeds, the port allows clients to access network resources. This mode is mostly used. 

eSpace 7850, 7830, 7820 and 7810 supports the EAP-MD5 authentication algorithm. Figure 

2-12 hows the process of EAP-MD5-based 802.1x authentication. 

Figure 2-12 Process of EAP-MD5-based 802.1x authentication 

 

 

The authentication process is as follows: 
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1. A client sends an EAPOL-Start packet to a device. 

2. The device receives the packet and sends an EAP-Request/Identity packet, requesting the 

client to send the user name. The device encapsulates frames from the client into a 

packet and sends the packet to the authentication server. 

3. The client sends the user name that is contained in the EAP-Response/Identity packet to 

the device. 

4. The authentication server searches the database for the user name in the packet and 

obtains the corresponding password. The authentication server uses a randomly 

generated encryption key to encrypt the password and sends the encryption key to the 

device through the Access-Challenge packet. 

5. The device sends the encryption key to the client. 

6. The client receives the EAP-Request/MD5 Challenge packet containing the encryption 

key. The client uses the encryption key to encrypt the password, generates an 

EAP-Response/MD5 Challenge packet, and sends the packet to the device. The device 

sends the packet to the authentication server. 

7. The encryption algorithm is irreversible normally. 

8. The authentication server receives the RADIUS Access-Request packet containing the 

encrypted password. It compares the encrypted password and the password encrypted by 

the authentication server itself. If they are the same, the server regards that the user is 

authorized and sends a RADIUS Access-Accept packet and an EAP-Success packet to 

the device. 

9. The device changes the port status and allows the client to access the network. The 

device periodically sends a handshake packet to the client to monitor the user status 

(online or offline). By default, if the device does not receive a response from the client 

after sending two handshake packets, the device takes the user offline, which enables the 

device to take the user offline if the user goes offline due to exceptions. 

10. If the user name or password set for the IP phone is incorrect, the device sends a Failure 

packet. After authentication fails, the IP phone sends a Start packet to request for 

authentication again. 

11. The client sends an EAPOL-Logoff packet to the device for going offline. The device 

changes the port status from authorized to unauthorized, and sends an EAP-Failure 

packet to the client. 

Phone Configuration 

1. Set 802.1X Mode to EAP-MD5, and set Identity and MD5 Password in the Advanced 

area on the Network tab page, as shown in Figure 2-13. 
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Figure 2-13 Setting 802.1x parameters 

 

 

2. Click Confirm. 

A dialog box is displayed, prompting you to restart the IP phone, as shown in Figure 

2-14. 

Figure 2-14 Restart dialog box 

 

 

3. Click OK. 

The IP phone restarts. 

After the IP phone is restarted, the 802.1x authentication is enabled. 

Basic Operations 

The basic operations on an IP phone remain the same after 802.1x authentication is enabled.  

If 802.1x authentication has been enabled when an IP phone is powered on, the IP phone 

sends a Start packet to the server three times at an interval of three seconds. Use Wireshark to 

catch authentication packets. The filter condition is eap||eapol. For details on how to use 

Wireshark, see 4.1.2 Using a Packet Capture Tool to Capture Packets. 

If the server does not need to be authenticated, the server does not respond to the request. 
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Figure 2-15 shows a Wireshark page displayed when the server does not require 

authentication. 

Figure 2-15 Wireshark page displayed when the server does not require authentication 

 

 

Figure 2-16 shows a Wireshark page displayed when the server requires authentication. 

Figure 2-16 Wireshark page displayed when the server requires authentication 

 

 

When authentication succeeds, the server sends a Success packet. If the user name or 

password set for the IP phone is incorrect, the server sends a Failure packet. If this happens, 

enter the correct user name and password on the web page. 
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Configuration File 

Table 2-13 eSpace 7850, 7830, 7820 and 7810 parameters in the 802.1x configuration file 

Section Header and 
Path Parameters Value Range Description 

[ 802.1X ] 

path = 

/config/Network/Netw

ork.cfg 

Mode 0 or 1 Indicates whether to enable 

the 802.1x function. 

0: no 

1: yes 

If the parameter is set to 1, 

the EAP-MD5 algorithm is 

enabled. 

Default value: 0 

Identity Character string User name. 

The parameter is left blank 

by default. 

MD5Passwd Character string Password corresponding to 

the user name. 

The parameter is left blank 

by default. 

 

2.3.6 Configuring Other Advanced Network Functions 

This section describes other parameters in the Advanced area on the Network tab page, as 

shown in Figure 2-17. 
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Figure 2-17 Setting other advanced network parameters 

 

 

Table 2-14 lists advanced network parameters in the red-framed parts. 
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Table 2-14 Other advanced network parameters 

Parameter Description 

Port Link 

WAN Port Link Network connection rate for the network port. The options are as 

follows: 

 auto negotiate: An IP phone selects a connection mode based on 

the network environment.  

 full duplex, 10 Mbps 

 full duplex, 100 Mbps 

 half duplex, 10 Mbps 

 half duplex, 100 Mbps 

Only auto negotiate is available to eSpace 7870. 

PC Port Link Network connection rate for the PC port. The options are as follows: 

 auto negotiate: An IP phone selects a connection mode based on 

the network environment.  

 full duplex, 10 Mbps 

 full duplex, 100 Mbps 

 half duplex, 10 Mbps 

 half duplex, 100 Mbps 

Only auto negotiate is available to eSpace 7870. 

QoS 

Voice QoS Voice QoS. 

Value range: 0 to 63 

SIP QoS Signaling QoS. 

Value range: 0 to 63 

Local RTP Port 

MaxRTPPort Maximum port number. 

MinRTPPort Minimum port number. The value must not be greater than the value 

of MaxRTPPort. 

SNMP (It is unavailable to eSpace 7870.) 

Port Port number for listening on the IP phone. 

Trusted Address IP address of the management device, for example, a PC. A maximum 

of three IP addresses are supported. Separate each two IP addresses 

with a space character. 

WebServer 

HTTP port Port number used for using HTTP to access web pages. 

Default value: 80 

HTTPS port Port number used for using HTTPS to access web pages. 
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Parameter Description 

Default value: 443 

Type Type for accessing web pages of the IP phone. The options are as 

follows: 

 Disabled: web pages cannot be accessed. 

 HTTP&HTTPS: HTTP or HTTPS can be used to access web 

pages. 

 HTTP only: Only HTTP can be used to access web pages. 

 HTTPs only: Only HTTPS can be used to access web pages. 

Span to PC port Indicates whether the PC port can receive Internet data packet.  

 Disabled: The PC port cannot receive Internet data packet. In this 

case, the IP phone functions as a switch. 

 Enabled: The PC port can receive Internet data packet. In this case, 

the IP phone functions as a hub. 

Default value: Disabled 

This parameter is unavailable to eSpace 7870 because it does not 

support transparent transmission. 

Registration 

random 

 Enabled: After power-on, an IP phone registers with the SIP server 

within the specified time segment. 

 Disabled: An IP phone registers with the SIP server immediately 

after power-on. 

 

Table 2-15 lists SNMP MIBs. 

Table 2-15 SNMP MIBs 

OID Name Value 

1.3.6.1.2.1.37459.2.1.1.0 phoneSyscontact.0 Sysadmin (root@localhost) 

1.3.6.1.2.1.37459.2.1.2.0 phoneSysname.0 IPPHONE 

1.3.6.1.2.1.37459.2.1.3.0 phoneSyslocation.0 Server Room 

1.3.6.1.2.1.37459.2.1.4.0 phoneUptime.0 System running period. The 

value is an integer. 

1.3.6.1.2.1.37459.2.1.5.0 phoneFirewareVersion.0 Phone firmware version. For 

example, 2.60.0.0. 

1.3.6.1.2.1.37459.2.1.6.0 phoneHardwareVersion.0 Hardware version. For 

example, 1.0.0.0. 

1.3.6.1.2.1.37459.2.1.7.0 phoneModel.0 Phone model. For example, 

eSpace 7850. 

1.3.6.1.2.1.37459.2.1.8.0 phoneMacAddress.0 MAC address. 

Format: 001565****** 
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OID Name Value 

1.3.6.1.2.1.37459.2.1.9.0 phoneIPAddress.0 IP address. The value is a 

dot-decimal notation. 

1.3.6.1.2.1.37459.2.1.10.0 phoneLastUpVersion.0 Target version to which the 

current version is 

automatically updated. 

Format: 

MacVersion[*]ComVersion[*] 

 

Configuration File 

Table 2-16 eSpace 7850, 7830, 7820 and 7810 parameters for configuring advanced network 

functions in the configuration file 

Section Header 
and Path Parameters 

Value 
Range Description 

[ Ethernet ] 

path = 

/config/Network/N

etwork.cfg 

WANPortLink 0 to 4 Network connection rate for the 

network port. 

 0: An IP phone selects a 

connection mode based on the 

network environment.  

 1: full duplex, 10 Mbit/s 

 2: full duplex, 100 Mbit/s 

 3: half duplex, 10 Mbit/s 

 4: half duplex, 100 Mbit/s 

Default value: 0 

PCPortLink 0 to 4 Network connection rate for the 

PC port. 

 0: An IP phone selects a 

connection mode based on the 

network environment.  

 1: full duplex, 10 Mbit/s 

 2: full duplex, 100 Mbit/s 

 3: half duplex, 10 Mbit/s 

 4: half duplex, 100 Mbit/s 

Default value: 0 

[ QOS ] 

path = 

/config/Network/N

etwork.cfg 

RTPTOS 0 to 63 Voice QoS. 

Default value: 40 

SIGNALTOS 0 to 63 Signaling QoS. 

Default value: 40 

[ snmp ] 

path = 

snmp_port 1 to 65535 Port number for listening on the 

IP phone. 
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Section Header 

and Path Parameters 
Value 

Range Description 

/config/Network/N

etwork.cfg 

The parameter is left blank by 

default. 

snmp_trusted_addr

ess 

IP address IP address for the management 

device.  

The parameter is left blank by 

default. 

[ RTPPORT ] 

path = 

/config/Network/N

etwork.cfg 

MaxRTPPort 0 to 65535 Maximum RTP port number. 

Default value: 11800 

MinRTPPort 0 to 65535 Minimum RTP port number. 

Default value: 11780 

[ port ] 

path = 

/config/Setting/Ad

vSetting.cfg 

http_port 1 to 65535 Port number used for using HTTP 

to access web pages. 

Default value: 80 

https_port 1 to 65535 Port number used for using 

HTTPS to access web pages. 

Default value: 443 

[ Webserver 

Type ] 

path = 

/config/Advanced/

Advanced.cfg 

WebType 0 to 3 Type for accessing web pages of 

the IP phone. The options are as 

follows: 

 0: web pages cannot be 

accessed. 

 1: HTTP or HTTPS can be 

used to access web pages. 

 2: Only HTTP can be used to 

access web pages. 

 3: Only HTTPS can be used to 

access web pages. 

Default value: 1 

[ LAN ] 

path = 

/config/Network/N

etwork.cfg 

SpanToPCPort 0 or 1 Indicates whether the PC port can 

receive Internet data packet. 

 0: no 

 1: yes 

Default value: 0 

[ REGSURGE ] 

path = 

/config/Network/N

etwork.cfg 

RegSurgePreventi

on 

0 to 60 Interval between IP phone 

power-on and account 

registration.  

Default value: 0 
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Table 2-17 eSpace 7870 parameters for configuring advanced network functions in the 

configuration file 

Section 
Header and 
Path Parameters Value Range Description 

[cfg:/phone/c

onfig/system.i

ni,reboot=1] 

QoS.RTPTOS 0 to 63 Voice QoS. 

Default value: 40 

QoS.SIGNALTOS 0 to 63 Signaling QoS. 

Default value: 40 

[cfg:/phone/c

onfig/system.i

ni,reboot=1] 

RTPPORT.MaxRT

PPort 

2 to 65534 Maximum RTP port number. 

Default value: 11800 

RTPPORT.MinRT

PPort 

2 to 65534 Minimum RTP port number. 

Default value: 11780 

[cfg:/phone/c

onfig/user.ini,

reboot=0] 

Port.http_port 1 to 65535 Port number used for using 

HTTP to access web pages. 

Default value: 80 

Port.https_port 1 to 65535 Port number used for using 

HTTPS to access web pages. 

Default value: 443 

[ cfg:/phone/c

onfig/user.ini,

reboot=0 ] 

Webserver 

Type.WebType 

0 to 3 Type for accessing web pages of 

the IP phone. The options are as 

follows: 

 0: web pages cannot be 

accessed. 

 1: HTTP or HTTPS can be 

used to access web pages. 

 2: Only HTTP can be used to 

access web pages. 

 3: Only HTTPS can be used 

to access web pages. 

Default value: 1 

[ cfg:/phone/c

onfig/system.i

ni] 

REGSURGE.RegS

urgePrevention 

0 to 60 Interval between IP phone 

power-on and account 

registration.  

Default value: 0 
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2.4 Phone Configuration 

2.4.1 Configuring Common Operations 

For details on how to configure an IP phone, see the Huawei IP Phone eSpace xxxx IP Phone 

User Manual, in which xxx represents the IP phone model. 

2.4.2 Configuring Softkey Layout 

The four soft keys on eSpace 7870, 7850, 7830 and 7820 are programmable when the IP 

phone is in the specified 12 states. You can configure the soft keys in the Softkey Layout area 

on the Phone tab page, as shown in Figure 2-18. 

Figure 2-18 Configuring soft keys 

 

 

Table 2-18 Parameters for configuring soft keys 

Field Description 

Custom SoftKey The settings for soft keys take effect only when the parameter is set to 

Enabled. 

Call States The options are as follows: 

 Dialing 

 Connecting 

 Transfer Connecting 

 RingBack 

 Transfer RingBack 
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Field Description 

 Call Failed 

 Call In 

 On Talk 

 Hold 

 Held 

 Transfer to 

 Conferenced 

Unselected 

Softkeys 

Functions that are not assigned to soft keys. 

Selected 

Softkeys(ordered 

by position) 

Functions that have been assigned to soft keys. If more than four keys 

are selected, the fourth key is automatically changed to More. The 

More key is used for switching to the next page. 

1<←>/<→> The left and right arrow buttons marked by 1 in Figure 2-18 are used to 

move soft keys between the Unselected Softkeys and Selected 

Softkeys(ordered by position) list boxes. 

2<↑>/<↓> The up and down arrow buttons marked by 2 in Figure 2-18 are used to 

adjust the order of soft keys in the Selected Softkeys(ordered by 

position) list box. 

Reset to Default Click this button to restore factory settings for soft keys. 

 

Table 2-19 lists keys that can be set on the 12 different pages. 

Table 2-19 Keys that can be set on the 12 different pages 

Key Value Key Function Pages Where the Key Value Can Be Set 

Empty No function is 

assigned to the soft 

key. If this option is 

selected, no 

information is 

displayed on an IP 

phone's LCD. 

Dialing, Connecting, Transfer Connecting, 

RingBack, Transfer RingBack, Call Failed, Call 

In, On Talk, Hold, Held, Transfer to, 

Conferenced 

History Views call history. Dialing 

Directory Views address 

books. 

Dialing, Transfer to 

Pool Accesses the 

address pool, 

including the call 

history, local 

address book, and 

remote address 

book. 

Dialing 
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Key Value Key Function Pages Where the Key Value Can Be Set 

Call Switch Switches calls. The 

status of a call is 

changed to Hold 

after the key is 

pressed. 

Dialing, Connecting, Transfer Connecting, 

RingBack, Transfer RingBack, Call Failed, Call 

In, On Talk, Hold, Held, Transfer to, 

Conferenced 

SWAP Switches calls. The 

call is resumed 

after the key is 

pressed. 

On Talk 

Line Selection Selects an account 

to make a call. 

Dialing 

Send Makes a call. Dialing, Transfer to 

IME Changes the input 

method. The input 

methods abc, ABC, 

2aB, and 123 are 

available. 

Dialing, Transfer to 

Delete Deletes characters. Dialing, RingBack, Transfer to 

Cancel Cancels an 

operation. 

Dialing, Connecting, Transfer Connecting, 

Transfer RingBack, Call Failed, On Talk, Hold, 

Held, Transfer to, Conferenced 

New Call Accesses the 

dialing page to 

make a new call. 

Call Failed, On Talk, Hold, Held 

Answer Answers an 

incoming call.  

Call In, On Talk, Hold, Held, Conferenced 

Reject Rejects an 

incoming call. 

Call In, On Talk, Hold, Held, Conferenced 

Silence Stops the ring tone. Call In 

Mute Mutes the call. 

After a user presses 

this key, others 

cannot hear the 

user's voice. 

On Talk, Conferenced 

Resume Resumes a call. Hold 

Forward Forwards an 

incoming call. 

Call In 

Transfer Transfers an 

incoming call. 

Transfer Connecting, Transfer RingBack, On 

Talk, Hold, Transfer to 

Conference Initiates a 

conference. 

On Talk 
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Key Value Key Function Pages Where the Key Value Can Be Set 

Split Splits a conference 

and establishes a 

call between the 

moderator and each 

participant. 

Conferenced 

 

Configuration File 

For details, see the description of [CustomSoftKey_Dialing] to [CustomSoftKey_ 

CallFailed] in the configuration file. 

2.4.3 Configuring DSS Keys 

Function Description 

Users can configure memory keys, line keys, programmable keys, and expansion modules to 

implement specific functions. 

Table 2-20 lists the number of DSS keys for eSpace 7870, 7850, 7830, 7820 and 7810. 

Table 2-20 Number of DSS keys for eSpace 7870, 7850, 7830, 7820 and 7810 

Model Memory Key Line Key Programmable Key eSpace 7803X 

eSpace 

7870 

10 6 14 38*2 

eSpace 

7850 

10 6 14 38 x 2 

eSpace 

7830 

10 3 14 38 x 2 

eSpace 

7820 

N/A 3 11 N/A 

eSpace 

7810 

N/A 2 9 N/A 

 

The four soft keys can be configured to make key distribution more user-friendly for users in 

various states, for example, when a user dialing a number, the ring tone is playing, or the 

calling and called parties are talking to each other. For details, see 2.4.2 Configuring Softkey 

Layout. 

Memory Key 

eSpace 7870, 7850, and 7830 have 10 memory keys for each. 

Each memory key has 28 configuration types. You can configure the 10 memory keys under 

Memory Key in the DSS Key area on the Phone tab page, as shown in Figure 2-19. 
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You can configure the 10 memory keys for eSpace 7870 under Memory Key in the DSS Key. 

Figure 2-19 Configuring memory keys 

 

 

Table 2-21 Parameters for configuring memory keys 

Parameter Description 

Key Memory key. 

Type Key type. Table 2-22 lists details about the types. 

Value The setting varies according to the functions that you assign. For 

example, if you assign the speed dial function to a memory key, enter 

the speed dial number to the Value text box. 

Line Account or group address book that a function is assigned to. 

 If the value of Type is not Local Group, XML Group, or LDAP, 

the options for this parameter are Auto and Line1 to Line 6. If 

Auto is selected, the default account is used. 

 If Type is set to Local Group, XML Group, or LDAP, group 

address books are available for this parameter.  

Extension Function code. Currently, this parameter needs to be set only when 

you configure the BLF function. 

Assume that the call pickup function code is *83. User A sets this 

parameter to *83 to configure the BLF function. When a call comes to 

user B, user A can press the BLF memory key to pick up the call for 

user B.  
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Table 2-22 Description of memory key types 

Type Description Setting 
Line 
Option 

N/A Assigns no function. N/A N/A 

Line Functions as a line key. N/A Auto, and 

Line 1 to 

Line 6 

Speed Dial Functions as the speed dial key. Enter a speed dial 

number. 

Auto, and 

Line 1 to 

Line 6 

BLF Listens on a number. When the BLF 

function is enabled, a user can know 

the current status (for example, idle, 

ringing, or talking) of the preset 

number. 

Enter a number to 

be listened on. 

Line 1 to 

Line 6 

Voice Mail Obtains voice messages. Enter the code for 

connecting to a 

voice mailbox. 

Line 1 to 

Line 6 

Pick Up Picks up calls for a preset number. 

When a preset number has an 

incoming call, a user can press the 

corresponding DSS key to pick up the 

call. 

Enter the function 

code and the 

picked up 

number, for 

example, *83123. 

In *83123, *83 is 

the function code 

indicating call 

pickup, and 123 

is the picked up 

number. 

Line 1 to 

Line 6 

Group Pickup Picks up calls for a group. When a 

preset group has an incoming call, a 

user can press the corresponding DSS 

key to pick up the call. 

Enter the function 

code for picking 

up calls of a 

group. For 

example, *78. 

Auto, and 

Line 1 to 

Line 6 

Call Park Parks a call when a user wants to store 

the call before retrieving it from 

another phone. For example, user A is 

in a conversation with user C. If user 

A wants to use another phone to 

continue the conversation, user A can 

park the call on an account of the SIP 

server. 

Set an account 

that calls are 

parked for, for 

example, 123. 

Line 1 to 

Line 6 

DTMF DTMF key. If a number is dialed 

frequently at the second dialing stage, 

the number can be set for the memory 

Enter a DTMF 

number. 

N/A 
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Type Description Setting 
Line 

Option 

key, which improves work efficiency. 

Prefix Specifies the same prefix of numbers 

that you often dial. The prefix (for 

example, 0086592) is displayed on the 

eSpace 7850 screen when you press 

this key. 

Enter the prefix. N/A 

Local Group Views the local address book. N/A Select 

Contacts 

(containing 

all local 

contacts) or 

an existing 

group. 

Remote 

Group 

Views a remote address book. You 

must upload a remote address book 

before viewing it. 

N/A Select a 

remote 

address 

book that 

you want to 

view. 

XML 

Browser 

Specifies a browser based on the 

Extensible Markup Language (XML). 

The browser can be used to view 

weather forecast, stock information, 

and news. 

This type is unavailable to eSpace 

7870. 

Enter a URL. N/A 

LDAP Views the LDAP address book. Before 

viewing the LDAP address book, you 

must configure it and set related 

parameters in the LDAP area on the 

Contacts tab page.  

For details, see 2.5.2 Configuring 

LDAP. 

N/A N/A 

Conference Sets up a conference during a 

conversation. 

N/A N/A 

Forward Forwards calls. The call forward 

function varies according to eSpace 

7850 status.  

When the IP phone is in the standby 

state, the key of this type provides the 

following functions: 

 Enables or disables the call 

forwarding unconditional (CFU) 

function when Value has been set. 

 Accesses the Always Forward 

Enter the number 

that calls are 

forwarded to. 

N/A 
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Type Description Setting 
Line 

Option 

page when Value is left blank.  

When the IP phone is in the ringing 

state, the key of this type provides the 

following functions: 

 Forwards incoming calls to the 

number in the Value text box when 

Value has been set. 

 Accesses the Forwarded To page 

when Value is left blank. A user 

can press the OK key to forward 

an incoming call. 

Transfer Transfers calls. If this parameter 

is left blank, this 

key functions as 

the transfer key. 

If this parameter 

is set to a number, 

press this key to 

transfer a call to 

the preset 

number. 

N/A 

Hold Functions as the Hold/Retrieve key. N/A N/A 

DND Functions as the DND key. N/A N/A 

Redial Functions as the redial key. When a 

user presses the key of this type on the 

IP phone in the standby state, the IP 

phone accesses the Dialed Calls page. 

N/A N/A 

Call Return Calls back the last calling party. N/A N/A 

Paging Enables the broadcast function. You 

need a VoIP PBX server where a 

paging group is configured to support 

the broadcast function. After you press 

this key, numbers in the paging groups 

are connected. 

Set numbers in 

the paging group. 

Auto, and 

Line 1 to 

Line 6 

Group 

Listening 

Functions as the group listening key. 

Use this function if multiple persons 

participate in a conference. 

 During a conversation in the 

handset mode, after you press the 

group listening key, the handset 

and speaker play voices, but the 

peer party can hear the voices only 

from the handset. 

 During a conversation in the 

headset mode, after you press the 

N/A N/A 
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Type Description Setting 
Line 

Option 

group listening key, the headset 

and speaker play voices, but the 

peer party can hear the voices only 

from the headset. 

Public Hold Is used for SCA group members to 

pause or resume a conversation. 

N/A N/A 

Private Hold Is used for SCA group members to 

pause a conversation. Only the 

member who pauses the conversation 

can resume it. 

N/A N/A 

Share Line Shares an account. Members who 

share the same account can check 

whether other members are using the 

account. 

Enter the SCA 

account. 

Select an 

account that 

registers the 

SCA 

function. 

 

Configuration File 

For details, see the description of [memory1] to [memory10] in the configuration file. 

Line Key 

You can configure the line keys under Line Key in the DSS Key area on the Phone tab page, 

as shown in Figure 2-20. 

Figure 2-20 Configuring line keys 
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The differences between line key settings and memory key settings for eSpace 7870, 7850 and 

7830 are as follows: 

 Compared with memory keys, lines keys do not have the setting N/A. 

 The default value of Type for line keys is Line, and the default value of Type for 

memory keys is N/A. 

 Compared with memory keys, line keys have the Label parameter. After Label is set, its 

value is displayed on the IP phone's LCD. The Label parameter is unavailable to eSpace 

7830. 

Compared with eSpace 7850, eSpace 7810 does not have the line key types: 

 Remote group 

 XML browser 

 LDAP 

Configuration File 

For details, see the description of [memory11] to [memory16] in the configuration file. 

Programmable Key 

eSpace 7870, 7850, and 7830 have 14 programmable keys for each, eSpace 7820 has 11 

programmable keys and eSpace 7810 has 9 programmable keys. You can configure 

programmable keys under Programmable Key in the DSS Key area on the Phone tab page. 
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Figure 2-21 Configuring programmable keys 

 

 

The programmable keys on eSpace 7870, 7850, and 7830 are as follows: four soft keys, four 

arrow keys (up, down, left, and right), OK, X, CONF, HOLD, MUTE, and TRAN. 

The programmable keys on eSpace 7820 are as follows: four soft keys, four arrow keys (up, 

down, left, and right), OK, X, TRAN. 

The programmable keys on eSpace 7810 are as follows: four arrow keys (up, down, left, and 

right), OK, X, CONF, HOLD, and TRAN. 

 

 

 The programmable keys are valid only when an IP phone is in the standby state. When the 

IP phone is in other states, factory settings are valid for the keys. 

 To restore factory settings, click Reset to Default under Programmable Key. 

Table 2-23 lists the types of programmable key. 

Table 2-23 Description of programmable key types 

Type Description Line Option Extension 

N/A  Keep the key xX, N/A N/A 
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Type Description Line Option Extension 

CONF, HOLD, 

MUTE, or TRAN 

unselected, the keys 

remain original 

function. 

 Keep other keys 

unselected, the key 

has been set no 

function. 

Directory Views address books. 

The local address book 

and remote address book 

can be set for eSpace 

7850, 7820 and 7830. 

Only the local address 

book can be set for 

eSpace 7810. 

N/A N/A 

History Queries call history. N/A N/A 

DND Functions as the DND 

key. 

N/A N/A 

Menu Accesses the Main 

Menu page. 

N/A N/A 

SwitchAccou

nt 

Switches accounts that 

are registered on eSpace 

7850. 

N/A N/A 

Forward Forwards calls. 

 Enables or disables 

the CFU function 

when Value has been 

set. 

 Accesses the Always 

Forward page when 

Value is left blank.  

N/A N/A 

Redial Functions as the redial 

key. When a user presses 

the key of this type on 

the IP phone in the 

standby state, the IP 

phone accesses the 

Dialed Calls page. 

N/A N/A 

Call Return Calls back the last calling 

party. 

N/A N/A 

Pick Up Picks up calls for a preset 

number. 

Line 1 to Line 6 Enter the function 

code and the picked 

up number, for 

example, *83123. In 
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Type Description Line Option Extension 

*83123, *83 is the 

function code 

indicating call 

pickup, and 123 is 

the picked up 

number. 

XML Group Views numbers of a 

group in the remote 

address book. 

This value is unavailable 

to eSpace 7810. 

Select a remote 

address book that you 

want to view. 

N/A 

XML 

PhoneBook 

Views a remote phone 

book. After a user 

presses the key of this 

type, the remote group 

list is displayed.  

This value is unavailable 

to eSpace 7810. 

N/A N/A 

Status Accesses the Status 

page. 

N/A N/A 

Speed Dial Functions as the speed 

dial key. 

Auto, and Line 1 to 

Line 6 

Enter a speed dial 

number. 

Local Group Views numbers of a 

group in the local address 

book. After a user 

presses the key of this 

type, the numbers of a 

group in the local address 

book are listed. 

Select all contacts or a 

group. 

N/A 

Local 

PhoneBook 

Views groups in the local 

address book. 

N/A N/A 

 

Configuration File 

For details, see the description of [programablekey1] to [programablekey14] in the 

configuration file. 

2.4.4 Configuring eSpace 7803X 

A maximum of two eSpace 7803Xs can be cascaded to eSpace 7870, 7850, and 7830 to 

extend DSS keys.  

To configure eSpace 7803Xs, access the web page for the IP phone to which eSpace 7803Xs 

are cascaded, click the Phone tab, and click EXT Key, as shown in Figure 2-22. 

To configure eSpace 7870, click the DSS Key tab and click EXT Key. 
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Figure 2-22 Configuring eSpace 7803X 

 

 

Table 2-24 Parameters for configuring eSpace 7803X 

Field Description 

Expansion Key ID of an expansion module. The value of Expansion Key for the 

first expansion module is 1, and the value of Expansion Key for 

the second expansion module is 2. 

Type There are 28 values of Type for keys (except Key1 and Key21), 

which are the same as the values for DSS keys. For details, see 

Table 2-22.  

For Key1, Type can be set to Switch in addition to the common 28 

options so that users can switch two function pages. 

For Key21, Type can be set only to Switch. 

Value/Line/Extension The values for the three parameters are the same as those for 

memory keys. For details, see Table 2-21. 

Label Key function name that is displayed on the eSpace 7803X 's LCD. 

 

Configuration File 

For details, see the description in the line under [memory16] in the configuration file. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 2 Single IP Phone Configuration 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

51 

 

2.4.5 Configuration Ring 

Function Description 

The distinctive ring tone service allows a user to identify the callers based on the ring tone. 

The ring tone is specified in the Alert-Info message in the SIP Invite signaling. The ring tone 

can be a local ring tone or a remote ring tone. 

Local ring tone: ring tone stored in the flash memory of an IP phone. 

Remote ring tone: ring tone that an IP phone downloads from a URL specified in the SIP 

Invite signaling. 

The SIP Invite signaling that the server sends control distinctive ring tones. Therefore, the 

distinctive ring tone service must be supported by the server. 

Principles 

The Alert-Info message in the SIP Invite signaling that the server sends to an IP phone 

specifies the ring tone. The Alert-Info message is in the following format: 

Alert-Info:URL;info=info text 

After receiving the message, the IP phone attempts to download the WAV ring tone file from 

the URL. If the IP phone fails to download the file, the IP phone plays the local ring tone 

associated with info text. 

Phone Configuration 

Set parameters for distinctive ring tones in the Ring area on the web configuration page, as 

shown in Figure 2-23. 
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Figure 2-23 Setting parameters for distinctive ring tones 

 

 

Table 2-25 lists parameters for configuring distinctive ring tones. 

Table 2-25 Parameters for configuring distinctive ring tones 

Field Description 

Internal Ringer Text This parameter, same as the info text parameter in the 

Alert-Info message, is associated with a local ring tone file. 

The parameter values vary according to the server type. For 

example, the SoftCo server has the following values: 

 alert-internal 

 alert-external 

 alert-centrex 

 alert-busycallback 

Internal Ringer File Ring tone file that is associated with the corresponding info 

text. 

In Figure 2-23, alert-internal is associated with Ring1.wav, 

alert-external is associated with Ring2.wav, alert-centrex is 

associated with Ring3.wav, and alert-busycallback is 

associated with Ring4.wav. 

 

An example is as follows: 

Alert-Info: http://www.example.com/sounds/moo.wav;info= alert-centrex 
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Assume that the settings in Figure 2-23 take effect. 

When the IP phone receives a call, the IP phone receives the Alert-Info message. The phone 

attempts to download the ring tone file from http://www.example.com/sounds/moo.wav. If the 

ring tone file is successfully downloaded, the IP phone plays it. Otherwise, the IP phone plays 

the Ring3.wav file. 

Configuration File 

Table 2-26 eSpace 7850, 7830, 7820 and 7810 parameters in the configuration file for distinctive 

ring tones 

Section Header and 
Path Parameters 

Permitted 
Values Description 

[ AlertInfo0 ] 

path = 

/config/Setting/Setting.

cfg 

Text Character 

string 

This parameter corresponds to 

the first Internal Ringer Text 

parameter. The parameter is 

left blank by default. 

Ringer Integer Local ring tone that is 

associated with the first 

Internal Ringer Text 

parameter. The value 1 

indicates Ring1.wav, the value 

2 indicates Ring2.wav, and the 

value n indicates Ringn.wav.  

Default value: 1 

Parameters for the other nine Internal Ringer Text parameters are the same as those for 

the first one. The only difference is the numbers in the headers. The second header is 

[ AlertInfo1 ], the third header is [ AlertInfo2 ], and the nth header is [ AlertInfo(n-1) ]. 

 

Table 2-27 eSpace 7870 parameters in the configuration file for distinctive ring tones 

Section Header and 
Path Parameters 

Permitted 
Values Description 

[cfg:/phone/config/use

r.ini,reboot=1] 

AlertInfo0.Text Character 

string 

This parameter corresponds 

to the first Internal Ringer 

Text parameter. The 

parameter is left blank by 

default. 

AlertInfo0.Ring

er 

Integer Local ring tone that is 

associated with the first 

Internal Ringer Text 
parameter. The value 1 

indicates Ring1.wav, the 

value 2 indicates 

Ring2.wav, and the value n 

indicates Ringn.wav.  

Default value: 1 
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Section Header and 

Path Parameters 
Permitted 

Values Description 

Parameters for the other nine Internal Ringer Text parameters are the same as those for 

the first one. The only difference is the numbers in the headers. The second header is 

[ AlertInfo1 ], the third header is [ AlertInfo2 ], and the nth header is [ AlertInfo(n-1) ]. 

 

2.4.6 Configuring the BLF Function 

Function Description 

The BLF function allows a user to listen on the status of other accounts. After the BLF 

function is assigned to a DSS key, users can press this key to implement the speed dial and 

call pick functions. 

For eSpace 7870, 7850, 7830, 7820 and 7810, the BLF indicator's state (on, off, or blinking) 

and color show the status of the listened-on account. 

Prerequisites 

The BLF function has been enabled for an account on the SIP server. For details, see the 

SoftCo VoIP Integrated Exchange Product Documentation. 

Phone Configuration 

Assume that the account 10002 for listening on other accounts has been configured on the SIP 

server. After configuring the SIP server, proceed as follows to configure the BLF function for 

an IP phone: 

1. Register the account 10002. 

Click the Account tab and set basic account parameters in the Basic area, as shown in 

Figure 2-24. 
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Figure 2-24 Setting basic account parameters 

 

 

2. Set the type of a DSS key to BLF. 

A memory key, a line key, and an expansion key can be assigned the BLF function. The 

following describes how to set a memory key as a BLF key. 
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Figure 2-25 Setting a memory key as a BLF key 

 

 

Access the web configuration page, click the Phone tab, and click DSS Key. Set a 

memory key under Memory Key. To set a memory key for eSpace 7870, click the DSS 

Key tab and click Memory Key. 

− Set Type to BLF. 

− Set Value to the listened-on account. 

− Set Line to the line that the account 10002 registers, for example, 1. 

− Set Extension to the call pickup function code specified on the SIP server. 

3. Click Confirm to save settings. 

Indicator Status Monitoring 
 When the listened-on account is in the idle state, press the BLF key to make a call to the 

listened-on account. 

 When the listened-on account is in the ringing state, press the BLF key to pick up the call 

for the account. 

Table 2-28 describes the mapping among the indicator type, indicator status, and account 

status. 

Table 2-28 Mapping among the indicator type, indicator status, and account status 

Indicator Type Indicator Status Account Status 

Line Key assigned with 

the BLF function 

Steady green The listened-on account is in the idle 

state. 
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Indicator Type Indicator Status Account Status 

Blinking green The listened-on account is in the 

occupied state. 

Off The BLF function is disabled. 

Memory Key assigned 

the BLF function 

Steady green The listened-on account is in the idle 

state. 

Steady red The listened-on account is in the 

talking state. 

Blinking red The listened-on account is in the 

ringing state. 

Off The BLF function is disabled. 

 

2.4.7 Configuring the SCA Function 

Function Description 

The share call appearance (SCA) function allows one account to be used by multiple phones. 

Users can monitor the account status on each phone. The function is mainly applied to the 

secretary service. 

After the manager and secretary service is enabled, a line of a manager can be bound to a line 

of the manager's secretary. When the manager's phone has an incoming call, the secretary's 

phone rings, and the indicator for the corresponding line of the manager blinks. After 

answering the call, the secretary can dial the manager's private phone number to forward the 

call to the manager. 

A manager can be bound to a maximum of two secretaries, and a secretary can be bound to a 

maximum of four managers. The line that is bound with the manager and secretary service 

must be a shared line. 

The following describes the manager and secretary service in the situation that a manager and 

a secretary are involved. 

Prerequisites 
 Two lines have been configured for the manager's phone. 

− Configured as an external line, line 1 is used by external users to call the manager and 

is bound to the secretary's phone. Line 2 is configured as a private line and is used by 

the secretary to call the manager. 

− If the manager needs to be configured with two secretaries, at least three lines must 

be configured for the manager's phone. Two of them are bound to two secretaries' 

phones, and one is configured as a private line. 

 Line 1 has been configured for the secretary's phone. 

− The line 1 is bound to the manager's phone. Line 2 is configured as a private line and 

is used to call the manager. 
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− When a secretary serves four managers, at least five lines must be configured for the 

secretary's phone. Four of them are bound to the external number of each manager, 

and one is configured as a private line. 

 The manager and secretary service has been configured for both the manager's line1 and 

the secretary's line1. For details, see the SoftCo VoIP Integrated Exchange Product 

Documentation. 

Phone Configuration 

The following procedure configures a manager account on the IP phone. The procedure for 

configuring a secretary account is similar. 

1. Access the web configuration page of the IP phone. 

2. Set line 1 as the shared line. 

Click the Account tab, and set Shared Line to SCA in the Advanced area, as shown in 

Figure 2-26. 
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Figure 2-26 Setting Shared Line 

 

 

3. Click Confirm to save settings. 

4. Click the Phone tab. Click DSS Key and set Line Key 1 in the Line Key area, as shown 

in Figure 2-27. 

− Set Type to Shared Line. 

− Set Value to the account number of line 1. 

− Set Line to 1. 
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Figure 2-27 Setting Line Key 1 

 

 

5. Click Confirm to save settings. 

2.4.8 Configuring the XML Browser 

Function Description 

The XML browser is developed for eSpace 7850, 7830 and 7820 based on XML and 

HTTP/HTTPS service. The XML browser can be used to browse only the XML files that are 

generated based on specific syntax by using tools such as PHP and JavaScript. HTTP or 

HTTPS is used to download the files to the IP phone. 

The XML browser enables users to use customized services such as weather report, stocks 

query, date query, address book, Google, news viewing, music playing, and terminal 

configuring. 

XML File Type 

The XML browser supports the following XML files: 

 TextMenu: menu item list in text format. For example, on the news main page, select a 

menu item to link to the corresponding news. 

 TextScreen: text page, for example, a page for viewing news. 

 InputScreen: input page, for example, a page for registering an account. 

 Directory: page for downloading address books. 

 Execute: page prompting an IP phone to run a command, for example, restart command 

or call making command. 

 Status: page that displays the IP phone status dynamically, for example, the DND service 

status and call forwarding status. 

 Configuration: file for setting IP phone parameters. 
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For details on the parameters in the seven types of XML files, see 5.7 XML Files Supported 

by the XML Browser. The seven types template of XML files are delivered with the software 

version and are available at http://support.huawei.com/. 

Server Configuration 

HTTP and HTTPS can be used to download files for the XML browser. For details on how to 

configure the HTTP server, see 5.2 Configuring the HTTP Server. 

Phone Configuration 

To assign the XML browser function to a DSS key, for example, a memory key, proceed as 

follows: 

1. Click DSS Key on the web configuration page. 

2. Under Memory Key, select XML Browser from the Type drop-down list box, and enter 

an XML address in the Value text box. 

Figure 2-28 Setting a DSS key type to XML browser 

 

 

3. Click Confirm. 

Basic Operations 

1. When an IP phone is in the standby state, press a DSS key of the XML browser type. 

2. After the page shown in Figure 2-29 is displayed, press the Select soft key to access the 

corresponding link address. 

You can press the More soft key to perform other operations such as dialing a number or 

enabling the DND service. The available operations are defined in the XML file on the 

server.  
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Figure 2-29 XML browser page 

 

 

2.4.9 Customizing the Phone Desktop (for eSpace 7870 Only) 

Function Description 

Users can customize desktop background and layout for their IP phones in an XML file. To 

use the customized desktop background and layout, users need only to upload this file. The 

XML file configures the following information: 

 Whether to display the following items on the desktop and their positions: 

− Clock: time 

− Date: date 

− State: icons indicating the current account and missed calls 

− Icon: icons indicating the DND, auto answer, voice message, and call transfer 

functions 

 Whether to display soft key icons on the desktop 

The positions of soft key icons are fixed and cannot be changed. 

 Wallpaper 

Each account can customize its own desktop. After an account switches to another account, 

the customized desktop changes accordingly. When the desktop customization function is 

disabled for an account, the default desktop is displayed on the main GUI. 

 

 

The customized desktop is applicable only to the main GUI of an IP phone. Other GUIs such 

as the menu and call interfaces are displayed in their default styles. 

XML File Generation 

Use the following tool to generate an XML file. Huawei technical support will notify you of 

any update on this tool promptly. 
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Log in to http://support.huawei.com/ to download XMLIdleScreen.exe.The path is 

SUPPORT > Software Center > Version Software > Application and Software Product 

Line > Application and Software Solution > Enterprise UC>IP Phone. 

1. Run XMLIdleScreen.exe. 

The main page is displayed, as shown in Figure 2-30. 

Figure 2-30 Main page 

 

 

2. Choose File > New, and create a file, as shown in Figure 2-31. 
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Figure 2-31 Creating an XML file 

 

 

Figure 2-31 shows the default position of each item on the phone main GUI. 

3. Click background, and click Browse to select a wallpaper, as shown in Figure 2-32. 
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Figure 2-32 Configuring a wallpaper 

 

 

4. Click clock, and drag the sliders on the X and Y coordinates to adjust the time position, 

as shown in Figure 2-33. 
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Figure 2-33 Setting the time position 

 

 

The methods of setting the date, status, and icons are similar. 

5. Click softkey, and select the Visible check box, as shown in Figure 2-34. 

After the Visible check box is selected, soft key icons will be displayed on the desktop. 
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Figure 2-34 Determining whether to display soft key icons 

 

 

6. Click Generate Xml, and select a path for storing the file. 

Phone Configuration 

1. Access the web configuration page and click the Account tab. In the Basic area, select 

and enable the account that requires a customized desktop. 

2. Set XMLIdleScreen Active to Enabled, as shown in Figure 2-35. 

Figure 2-35 Setting XMLIdleScreen Active 

 

 

3. Upload the new XML file to the SIP server using HTTP, HTTPS, TFTP, or FTP. 

For details on how to configure the SIP server, see 5.1 Configuring the TFTP Server 

(3CDaemon TFTP Server for Example) and 5.2 Configuring the HTTP Server. 

4. Set XmlIdleScreen URL and click Confirm. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 2 Single IP Phone Configuration 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

68 

 

Application Scenario 

After the desktop is customized and the desktop customization function is enabled for an 

account, the IP phone will automatically download the XML file from the URL specified by 

XmlIdelScreen URL. 

If multiple accounts have customized desktops, press the left and right arrow keys to switch 

accounts to display the corresponding desktop. If an account has no customized desktop or 

has disabled the desktop customization function, the default desktop is displayed on the main 

GUI. 

2.4.10 Advanced Functions 

On the web configuration page, click the Phone tab, and click Features to set advanced 

functions, as shown in Figure 2-36. 
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Figure 2-36 Setting advanced functions 
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The parameters framed in red in Figure 2-36 are not described in the Huawei IP Phone 

eSpace 78XX User Manual. Table 2-29lists the parameters. 

Table 2-29 Parameters for advanced functions 

Parameter Description 

Reserve # in User Name If this parameter is set to Enabled, the number sign (#) in an 

account name will be converted into %23. 

RFC 2543 Hold The call hold function supports both RFC2543 and RFC3261. 

If this parameter is set to Disabled, RFC3261 is used. 

Use Outbound Proxy If this parameter is set to Enabled, information exchanged 

between the calling and called parties is transferred through 

the outbound proxy server. 

IsDeal180 If this parameter is set to Enabled, the SIP server will handle 

a 180 message following a 183 message. 

Logon Wizard If this parameter is set to Enabled, an IP phone will 

automatically enter the account setting GUI at startup when no 

account has been registered. 

This parameter is unavailable to eSpace 7870. 

PswPrefix If PswDial is set to Enabled, the N (specified by PswLength) 

digits dialed following xxx (specified by PswPrefix) are 

displayed as asterisks (*). 

This parameter is unavailable to eSpace 7870. 

PswLength 

PswDial 

PushXML Server IP IP address of the XML server from which an IP phone 

receives XML files. The XML files must be of the format 

supported by the XML Browser. For details, see 5.7 XML 

Files Supported by the XML Browser. 

This parameter is unavailable to eSpace 7870 and 7810. 

SaveCallHistory If this parameter is set to Disabled, no call history is saved. 

 

2.5 Contacts Configuration 

2.5.1 Configuring the Remote Phone Book 

Function Description 

In addition to local phone books on IP phones, enterprises usually publish public address 

books, which are maintained and updated on the SIP server or IP PBX. The function of 

accessing remote phone books must be enabled for IP phones to download the latest public 

address book. eSpace 7870, 7850, 7830 and 7820 can download and search for remote phone 

books and save contact information to the local phone book. 
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Remote Address Book URL 

The URL for a remote address book must be linked to an XML address book and must be in 

either of the following formats: 

 Common URL format: http://<host:port>/[folder name]/phonebook name.xml 

 PHP format: http://<host:port>/[ folder 

name]/search.php?[IP_ADDR=#IP][&MAC_ADDR=#MAC][&NAME=#SEARCH] 

 
The fields in the square brackets are optional. 

The server determines the content of the data file to be sent based on the parameters in a PHP 

URL, and therefore the obtained data file is also an XML file.  

The fields in a PHP URL are described as follows: 

 IP_ADDR=#IP 

Replace #IP with an IP address. The server verifies whether the IP address has the right 

to download XML address books. 

 MAC_ADDR=#MAC 

Replace #MAC with a MAC address. The server verifies whether the MAC address has 

the right to download XML address books. 

 NAME=#SEARCH 

Replace #SEARCH with a contact name. The server searches for the contact name and 

records the search result into an XML file. Then the server sends the file to the IP phone. 

If the URL contains this field, the IP phone regards that the server has the search 

function. 

Downloading a Remote Phone book 

To download a remote phone book, proceed as follows: 

1. Prepare an XML file. 

Remote phone books are classified into contact XML files and menu XML files. You can 

use UltraEdit to edit XML files. 

The three .xml files are delivered with the software version and are available at 

http://support.huawei.com/.The IP phone downloads the Menu.xml file first, and then 

downloads the PC.xml and Tester.xml files based on the URLs in the Menu.xml file. 

 

 

The attachments are only examples. Add XML files and modify them as required. 

2. Configure the server. 

FTP, TFTP, HTTP, and HTTPS can be used to download remote phone books. This 

document describes how to use HTTP to download remote phone books. For details on 

how to configure the HTTP server, see 5.2 Configuring the HTTP Server. 

3. Set parameters related to the remote phone book on the IP phone's web page. 

To set parameters related to the remote phone book on the IP phone's web page, proceed 

as follows: 
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a. Log in to the IP phone's web page. 

b. Click the Contacts tab, and click Remote PhoneBook. Set Phone Book Url and 

Phone Book Name, as shown in Figure 2-37. 

c. The Phone Book Url parameter indicates the URL for downloading the file, for 

example,http://192.169.1.21:80/Menu.xml. The Phone Book Name parameter 

indicates the name to be displayed on the IP phone's LCD. You can set Phone Book 

Name to any value, for example, Company. 

A total of five remote phone books are supported by eSpace 7870, 7850, 7830 and 

7820. 

Figure 2-37 Setting remote phone books 

 

 

d. Click Confirm. 

4. View the remote phone book on the IP phone. 

a. Press the Directory soft key when the IP phone is in the standby state. 

The [Directory] page is displayed. 

b. Press the number key 3. 

You can view Company on the [Remote Group] page that is displayed. 

c. Press the Enter key. 

The contact page is displayed, as shown in Figure 2-38. 

Figure 2-38 Contact page 

 

 

d. Press the up arrow key or down arrow key to select Tester or PC. 
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e. Press the Enter key. 

The contacts in the group are listed. 

Searching a Remote Phone book 

Enter the URL with the search function under Phone Book URL, as shown in Figure 2-39. 

http://<host:port>/search.php?NAME=#SEARCH 

 
HTTP servers do not support PHP URLs and therefore cannot function as a search server. To implement 

the search function, install the AppServ on a server. 

Figure 2-39 Setting the search function for remote phone books 

 

 

After the URL with the search function is set, you can find the Search button on the remote 

phone book page, as shown in Figure 2-40. 

Figure 2-40 Searching a remote phone book 

 

 

Press the Search soft key to search for contacts. 
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Configuration File 

Table 2-30 eSpace 7850, 7830, 7820 and 7810 parameters in the configuration file for remote 

phone books 

Section Header 
and Path Parameters Permitted Values Description 

[ RemotePhoneBook

0 ] 

path = 

/config/Setting/Settin

g.cfg 

URL Character string URL for the first 

remote address 

book, which must be 

in XML format. 

Example: 

http://10.2.3.3/phon

ebook/friend.xml 

The parameter is left 

blank by default. 

Name Character string Name of the first 

remote address 

book. 

The parameter is left 

blank by default. 

Parameters for the other four remote addresses are the same as those for the first one. The 

only difference is the numbers in the headers. 

The header for the second remote address book is [ RemotePhoneBook1 ], the header for 

the third remote address book is [ RemotePhoneBook2 ], and the header for the nth remote 

address book is [ RemotePhoneBook(n-1) ]. 

 

Table 2-31 eSpace 7870 parameters in the configuration file for remote address books 

Section Header 
and Path Parameters Permitted Values Description 

[cfg:/phone/config/us

er.ini,reboot=0] 

RemotePhoneBook

0.URL 

Character string URL for the first 

remote address 

book, which must 

be in XML format. 

Example: 

http://192.168.0.231

/vin/phonebook1.x

ml 

The parameter is 

left blank by 

default. 

RemotePhoneBook

0.Name 

Character string Name of the first 

remote address 

book. 

The parameter is 
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Section Header 

and Path Parameters Permitted Values Description 

left blank by 

default. 

Parameters for the other four remote addresses are the same as those for the first one. The 

only difference is the numbers in the headers. 

The header for the second remote address book is [ RemotePhoneBook1 ], the header for 

the third remote address book is [ RemotePhoneBook2 ], and the header for the nth remote 

address book is [ RemotePhoneBook(n-1) ]. 

 

2.5.2 Configuring LDAP 

Function Description 

Based on X.500, the Lightweight Directory Access Protocol (LDAP) is an application 

protocol for reading and editing directories over an IP network. LDAP supports TCP/IP. 

For example, in a tree structure, the root is the company name, the company contains 

departments, and a department contains employees. The IP phone can search for contacts 

based on specific rules. For example, the IP phone searches for contacts whose department 

names contain J. 

eSpace 7870, 7850, 7830 and 7820 that support LDAP provide the following functions: 

 Search for contacts.  

After a user presses the LDAP DSS key and enters a number or letter, the IP phone 

searches the LDAP server for contacts based on a specific rule and displays the search 

result on the LCD. The user then can select a contact and initiate a call, or add the 

contact to the local address book or blacklist. 

 Display the calling party's name. 

After receiving a call, the IP phone searches the local address book for the calling 

number. If no record is found, the IP phone searches the LDAP server for the contact and 

displays the search result on the IP phone's LCD. 

 Search for the number that a user dials. 

Each time a user presses a number key, the IP phone searches the LDAP server for the 

matching number. If records are found, the IP phone displays the records on the LCD. 

Then the user can select a contact to make a call. 

Web Configuration 

Before using the lightweight directory access protocol (LDAP) directory, you must first set up 

the LDAP server(For example, Windows 2003 Server active directory (AD) ). For details 

about how to install and set up the Windows 2003 Server AD, see 5.6 Using Windows 2003 

Server AD. 

Table 2-32 lists common LDAP attributes for eSpace 7870, 7850, 7830 and 7820. 
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Table 2-32 Common LDAP attributes 

Attribute Full Name Description 

cn Common Name Attributes in the character string for connecting an IP 

phone to a server to implement the LDAP function. 

The character string is in the format ldap://servername/DN, 

in which DN contains cn, ou, and dc. For example, 

cn=test,ou=developer,dc=domainname,dc=com indicates 

that the test object is in the developer unit in the 

domainname.com domain. The value of cn must be unique. 

The LDAP directory is similar to the file system directory, 

for example, dc=Redmond,dc=wa,dc=Microsoft,dc=com, 

which is similar to com\Microsoft\wa\ Redmond in the file 

system. 

ou Organizational 

Unit Name 

dc Domain 

Component 

o Organization 

Name 

Organization name. 

sn Surname Family name. 

gn Given Name First name. 

 

To use LDAP function, prepare the server environment first. (For example, the Windows 2003 

Server AD is installed and contacts are added to the server. )Then set parameters on the IP 

phone's web page as follows: 

1. Access the web configuration page. 

2. Click the Phone tab, and click DSS Key. Select a memory key or a line key, and select 

LDAP from Type, as shown in Figure 2-41. 
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Figure 2-41 Assigning LDAP to a DSS key 

 

 

3. Click Confirm. 

4. Click the Contacts tab, and click LDAP. 

5. Set LDAP parameters, as shown in Figure 2-42. 
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Figure 2-42 Setting LDAP parameters 

 

 

Table 2-33 lists parameters in the LDAP area. 

6. Click Confirm. 

7. Then presses the LDAP DSS key and enters a number or letter, the IP phone searches the 

LDAP server (the Windows 2003 Server AD) for contacts based on a specific rule and 

displays the search result on the LCD.  

Table 2-33 Parameters for configuring LDAP 

Parame
ter Description 

Example 

LDAP 

Name 

Filter 

Name filter. After you enter a name, the IP phone 

uses the name filter to search the LDAP server for 

the contact. The settings for the name filter must be 

based on RFC 2254. The entered names will 

(|(givenName=%)(sn=%

)) 
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Parame

ter Description 
Example 

replace % in the name filter. 

Examples are as follows: 

 (|(cn=%)(sn=%)) 

The LDAP server sends the IP phone the records 

with cn or sn starting with the characters dialed by a 

user. 

 (!(cn=%)) 

The LDAP server does not send the IP phone the 

records with cn or sn starting with the characters 

dialed by a user. 

LDAP 

Number 

Filter 

Number filter. After you enter a number, the IP 

phone uses the number filter to search the LDAP 

server for the contact. The settings for the number 

filter must be based on RFC 2254. The entered 

numbers will replace % in the number filter. 

Examples are as follows: 

 (|(telephoneNumber=%)(Mobile=%)(ipPhone=%

)) 

The LDAP server sends the IP phone the records 

with telephoneNumber, Mobile, or ipPhone starting 

with the characters dialed by a user. 

 (&(telephoneNumber=%)(sn=%)) 

The LDAP server does not send the IP phone the 

records with telephoneNumber or sn starting with the 

characters dialed by a user. 

(|(telephoneNumber=%)

(mobile=%)) 

Server 

Address 

IP address or domain name of the LDAP server. 

Examples are as follows: 

 192.168.1.100 

 lday.company.com 

IP address of the LDAP 

server (The Windows 

2003 Server AD). 

Port Port number of the LDAP server. 

Default value: 389  

389 

Base Root directory that the IP phone searches. For 

example, if the value is dc=Redmond,dc=wa, the 

root directory is wa\Redmond. 

dc=test，dc=com 

UserNa

me 

User name for logging in to the LDAP server.  

If the LDAP server allows anonymous visitors to 

access, leave the parameter blank;  

otherwise, set UserName and Password to the values 

set by the LDAP server administrator. 

For example: cn=manager,dc=company,dc=cn. 

 dongle@test.com 

An existing user name 

in the Windows 2003 

Server AD. 

Passwor

d 

Password for logging in to the LDAP server. The 

password is set by the LDAP server administrator. 

Huawei123 
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Parame

ter Description 
Example 

Max.Hit

s(1~320

00) 

Maximum number of records in the search result.  

If the number of records found in the LDAP server is 

larger than the setting, the server sends records (total 

number: Max.Hits) to the IP phone. The server sends 

all records in the search result to the IP phone if this 

parameter is left blank. 

The factory setting is 50. 

NOTE 

If excessive contact records are found, the search 

speed is slow. Set the parameter based on the 

network bandwidth. 

50 

LDAP 

Name 

Attribut

es 

LDAP name attributes. The search result that the 

LDAP server sends to the IP phone must contain 

these name attributes. 

Examples are as follows: 

 cn sn displayName 

The search result that the LDAP server sends to the 

IP phone must contain the cn, sn, and displayName 

attributes. 

 givenName 

The search result that the LDAP server sends to the 

IP phone must contain the givenName attribute. 

 vorName nachName 

The search result that the LDAP server sends to the 

IP phone must contain the vorName and nachName 

attributes. 

givenName sn cn 

LDAP 

Number 

Attribut

es 

LDAP number attributes. The search result that the 

LDAP server sends to the IP phone must contain 

these number attributes. 

Examples are as follows: 

 Mobile telephoneNumber ipPhone 

The search result that the LDAP server sends to the 

IP phone must contain the Mobile, 

telephoneNumber, and ipPhone attributes. 

 Home Private Office 

The search result that the LDAP server sends to the 

IP phone must contain the Home, Private, and Office 

attributes. 

telephoneNumber 

mobile 

LDAP 

Display 

Name 

Attributes whose information is displayed on the IP 

phone's LCD. 

Example: %cn %sn 

The example indicates that the values of cn and sn 

are displayed on the IP phone's LCD. 

%sn  %givenName %c

n 
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Parame

ter Description 
Example 

Protocol Protocol version. The options are Version2 and 

Version3. The protocol version selected on the IP 

phone must be the same as the parameter setting. 

Version3 

Search 

Delay(

ms)(0~2

000) 

Search delay period. A delay period later than the 

search operation, the IP phone displays the search 

results on the LCD. 

Unit: millisecond 

2000 

LDAP 

Lookup 

For 

Incomin

g Call 

The value Enabled indicates that the IP phone 

searches the LDAP server for the calling number and 

displays the calling party's name on the LCD. The 

value Disabled indicates that the IP phone does not 

search the LDAP server for the calling number. 

Disabled 

LDAP 

Sorting 

Results 

The value Enabled indicates that the IP phone sorts 

records that are found by display name (or by 

number if only numbers are contained in the search 

result). The value Disabled indicates that the IP 

phone does not sort records that are found. 

Disabled 

LDAP 

Lookup 

For 

PreDial/

Dial 

The value Enabled indicates that the IP phone 

searches the LDAP server for the characters that a 

user dials. 

Disabled 

 

Configuration File 

For eSpace 7850, 7830 and 7820 details, see the description of [LDAP] in the configuration 

file. 

For eSpace 7870 details, see [ cfg:/phone/config/Contacts/LDAP.cfg ] in the configuration 

file. 

2.6 TLS/SSL Authentication 

Function Description 

Transport Layer Security (TLS) and its predecessor, Secure Sockets Layer (SSL), are 

cryptographic protocols that provide communications security over the Internet. TLS and SSL 

encrypt the segments of network connections above the transport layer, using cryptography 

for privacy and a keyed message authentication code for message reliability. TLS is used to 

encapsulate specific application protocols such as HTTP, FTP, SMTP, NNTP, and XMPP. For 

details about TLS and SSL, visit the website 

http://en.wikipedia.org/wiki/SSL_certificate#TLS_version_1.1. 

TLS/SSL authentication is used in the following scenarios: 
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 An IP phone uses HTTPS to perform automatic provision, during which the IP phone 

functions as a client. 

 When a user uses HTTPS to access an IP phone's web page, the IP phone functions as a 

server. 

Encryption Algorithm 

Encrypted transmission occurs when data sender uses the encryption key to encrypt 

information and then sends the encrypted information to the recipient. The data recipient uses 

the decryption key to decrypt the information and reads the information. Two common 

encryption algorithms are described as follows: 

 Symmetric-key algorithm: The encryption key is trivially related to the decryption key, 

in that they may be identical or there is a simple transformation to go between the two 

keys. 

 Asymmetric-key algorithm: This algorithm involves a public key and a private key. If the 

public key is used for encryption, only the corresponding private key can be used for 

decryption; if the private key is used for encryption, only the corresponding public key 

can be used for decryption. 

TLS/SSL Communication Principle 

The process for TLS/SSL communication is as follows: 

1. The client and the server use the asymmetric encryption algorithm to negotiate a session 

key. The sender generates a symmetric session key and uses the public key to encrypt the 

session key. Then the sender sends the encrypted information to the recipient.  

2. The recipient uses the private key to decrypt the session key. 

3. The sender uses the session key to encrypt a file and sends the encrypted file to the 

recipient.  

4. The recipient uses the session key to decrypt the file into a plain text. 

The file transmission is secure because only the private key of the recipient can be used for 

decrypting the session key. 

Communication Process 

After the TLS/SSL connection is set up, data can be transmitted securely. Figure 2-43 shows 

the transmission process. 
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Figure 2-43 TLS/SSL data transmission process 

 

 

1. The client sends a ClientHello request to the server, asking to set up a connection. The 

request contains the encryption methods supported by the client for negotiation. 

2. The server sends a ServerHello message back to negotiate an encryption method and 

sends a trusted certificate to the client. The certificate contains the public key of the 

server. 

3. If the client trusts the server, the client sends the server the session key that is encrypted 

by the public key of the server. The client also asks the server to use the session key for 

file encryption and transmission. 

4. The server receives the information from the client and uses the session key to encrypt 

all of the information that will be sent to the client. 

An IP phone functions as a client 

When an IP phone initiates an SSL connection, the IP phone functions as a client. Generally, 

the client uses the authentication certificate to determine whether the server is reliable, for 

example, when an IP phone is automatically upgraded in HTTPS mode. To configure the auto 

provision function, click the Security tab, and click Trusted Certificates, as shown in Figure 

2-44. 
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Figure 2-44 Configuring the auto provision function 

 

 

Table 2-34 ists parameters for configuring the auto provision function. 

Table 2-34 Parameters for configuring the auto provision function 

Parameter Description 

Area Root certificate list imported to an IP phone. 

Only Accept Trusted 

Certificate 

Indicates whether to enable the trust connection. 

If Enabled is selected, the imported root certification is used 

to authenticate the signature in the server certificate. If the 

authentication fails, the IP phone stops communicating with 

the server.  

If Disabled is selected, the IP phone always communicates 

with the server even if the trusted certificate does not exist or 

is incorrect. 

Import Trusted Certificate Click Browse under Import Trusted Certificate, select a 

certificate file, and click Upload to import the root 

certificate. 

 

To configure the auto provision function, proceed as follows: 

1. Configure an HTTPS server and provide the IP phone user with a root certificate.  

2. Access the web configuration page, click the Security tab, and click Trusted 

Certificates. 

3. Select Enabled from the Only Accept Trusted Certificate drop-down list box. 
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4. Click Browse under Import Trusted Certificate, select a certificate file, and click 

Upload to import the root certificate. 

5. In the Advanced area on the Upgrade tab page, set URL to a value starting with https://, 

as shown in Figure 2-45. 

To configure the auto provision function for eSpace 7870, click the Phone tab and click 

Auto Provision. 

Figure 2-45 Setting URL for HTTPS auto provision function 

 

 

The IP phone uses HTTPS to communicate with the server and uses the imported root 

certificate to authenticate the server. If the server can be authenticated, the IP phone uses 

HTTPS to download files. 

 
For details about the auto provision function, see 3 Batch Configuration and Upgrade of IP Phones. 

An IP phone functions as a server 

When a user uses HTTPS to access an IP phone's web page, the IP phone functions as a server. 

During communication, the IP phone sends trusted certificate to the browser. You can upload 

a trusted certificate in the Server Certificates area on the Security tab page, as shown in 

Figure 2-46. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 2 Single IP Phone Configuration 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

87 

 

Figure 2-46 Uploading a trusted certificate 

 

 

An IP phone is authenticated as a client 

Generally, the client verifies whether the server is reliable. In some cases, the server verifies 

whether the client is reliable, which is determined by the server configurations. When an IP 

phone is connected to an HTTPS server, the IP phone sends its client certificate to the server. 

The client certificate is uploaded in the Server Certificates area on the Security tab page. 

2.7 Upgrade and Restore 

 

 

Do not power off an IP phone during the upgrade. Otherwise, writing to the flash memory 

fails and the IP phone is down. If the IP phone is down, perform the emergent recovery or 

deliver the IP phone to the factory for repairing. 

2.7.1 Upgrading an IP Phone Manually 

You can manually upgrade an IP phone on the web page shown in Figure 2-47. 
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Figure 2-47 Upgrading an IP phone manually 

 

 

1. In the Basic area on the Upgrade tab page, click Browse under Select and Upgrade 

Firmware, and select the software to be upgraded. 

To upgrade eSpace 7870, click the Phone tab and click Upgrade. 

2. Click Upgrade. 

The IP phone starts to upgrade. After the upgrade finishes, the IP phone automatically 

restarts. 

3. Verify that the setting of Firmware Version on the Status tab page is the target version 

number. 

After the phone restarts, access the web configuration page, and verify that the value of 

Firmware Version on the Status tab page is updated. 

2.7.2 Firmware-based Restore 

Function Description 

If exceptions occur during firmware upgrade, the upgrade fails, and devices cannot be started. 

In this case, send the devices to the manufacturer to for repairing. This function is provided 

for administrators who are responsible for maintenance. 

 

 

This function is implemented in BootLoad on an IP phone, but BootLoad cannot be upgraded. 

Therefore, this function is supported only when the original version of the bin file is A.40.C.D 

(for example, 2.60.94.2) or a later version. If the original version of the bin file is A.30.C.D or 

an earlier version, the IP phone does not support this function, and only manufacturer 

engineers can repair it. 
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This section is applicable to eSpace 7870, 7850, 7830, 7820 and 7810. If eSpace 7870 fails to 

be upgraded, power it off and on. An IP address will be displayed on the LCD at startup. Use 

this IP address to access the web configuration page and upgrade the phone again. 

Prerequisites 

Before using the firmware to restore software, prepare the following items: 

 Computer where the TFTP server is installed. 

For details on how to set up the TFTP server environment, see 5.1 Configuring the TFTP 

Server (3CDaemon TFTP Server for Example). 

Verify that the phone IP address and the computer IP address are on the same network 

segment. 

 Firmware file for restoring software. 

Upgrade Procedure 

1. Connect the computer to a LAN and set the IP address to a proper value, for example, 

192.168.0.100. 

2. Copy the firmware file to the TFTP server path (for example, C:/TFTP) specified in the 

Upload/Download area, and rename the file based on the phone model. 

− To upgrade eSpace 7850, rename the file to t28.rom. 

− To upgrade eSpace 7830, rename the file to t26.rom. 

− To upgrade eSpace 7820, rename the file to t22.rom. 

− To upgrade eSpace 7810, rename the file to t20.rom. 

3. Use the network cable to connect a faulty IP phone to the LAN. 

4. Hold down the SPK key and power on the eSpace 7850. 

Three seconds later, the firmware restore page is displayed. 

Figure 2-48 shows the restore page for eSpace 7850. 

Figure 2-48 Firmware restore page 

 

 

5. Press numbers keys and arrow keys to set the IP address of the IP phone, for example, 

192.168.0.101. 
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Ensure that the IP address of the phone is in the same segment as the IP address of the 

computer. 

6. Press the down arrow key. 

7. Set Netmask and press the down arrow key. 

Set IP Gateway and press the down arrow key. Set TFTP Server. The value of TFTP 

Server is the IP address of the computer where the TFTP server is installed. 

8. Press the OK key. 

The IP phone sends a request to the specified TFTP server, downloads the firmware file, 

and displays the following information: 

Updating Firmware. 

Do not Poweroff!!! 

The IP phone restarts automatically, and the following information is displayed on the 

LCD: 

System is booting. 

Please wait… 

9. After the IP phone restarts, press the OK key. Access the Status page. View the 

firmware version and verify that the IP phone is upgraded to the software version on the 

TFTP server. 
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3 Batch Configuration and Upgrade of IP 
Phones 

3.1 Overview 

The global configuration file on the HTTP server is used to configure and upgrade IP phones 

in batches. 

During DHCP server configuration, a 246 parameter is defined for setting the URL of the 

global configuration file. After this parameter is set, the DHCP server sends the URL to the IP 

phone that applies for an IP address. The IP phone then downloads the configuration file from 

this URL. 

The configuration file contains the IP addresses of the servers where the firmware version file, 

ring tone files, and local address book files are stored. 

The batch configuration and upgrade of IP phones have the following features:  

 IP phones of the same model use the same configuration file. 

For example, you only need to prepare one configuration file for all eSpace 7850 phones.  

 IP phones obtain the required firmware version file URL from the configuration file.  

After obtaining the global configuration file, IP phones download the firmware version 

file based on the URL in the configuration file for batch upgrade. 

 IP phones obtain URLs from the configuration file to download ring tone files, local 

address book files, and other files. 

3.2 Making Configuration File Templates 

IP phones of the same model use the same configuration file. The configuration file name for 

each phone model is as follows: 

 For eSpace 7810, the file name is 7810.cfg. 

 For eSpace 7820, the file name is 7820.cfg. 

 For eSpace 7830, the file name is 7830.cfg. 

 For eSpace 7850, the file name is 7850.cfg. 

 For eSpace 7870, the file name is 7870.cfg. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 3 Batch Configuration and Upgrade of IP Phones 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

92 

 

3.2.1 Modifying Configuration File Templates 

A global configuration file template is provided for deployment. When making a 

configuration file, modify parameter settings such as the IP address of the IP phone 

registration server and NTP address in the template to meet onsite requirements. 

The global configuration file template is delivered with the software version and is available 

at http://support.huawei.com/.The path is SUPPORT > Software Center > Version 

Software > Application and Software Product Line > Application and Software 

Solution > Enterprise UC>IP Phone. 

 
eSpace 7810, eSpace 7820, eSpace 7830, eSpace 7850 use the same configuration file. When loading the 

configuration file to a phone, change the name of the configuration file to the model name of the phone. 

The configuration template is a .cfg file. Each section in the template consists of a header, a 

path, and several parameters. 

Use the Wordpad to open the file template, and modify parameter settings. 

Figure 3-1 shows the configuration file template. 

Figure 3-1 Configuration file template 

 

 

The attachment eSpace 7810&7820&7830&7850 Configuration File Parameter Description  

describes parameters in the configuration file for eSpace 7850, 7830, 7820 and 7810  is 

available at http://support.huawei.com/. 

The attachment eSpace 7870 Configuration File Parameter Description describes parameters 

in the configuration file for eSpace 7870 is available at http://support.huawei.com/. 

3.2.2 Updating Files 

The configuration file lists the files that an IP phone needs to update. 
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Updating the Firmware Version File 

To update the firmware version file, you need to configure information about the server where 

the firmware version file is stored. 

 

 

The following describes the [ firmware ] section in the configuration file for eSpace 7850, 

7830, 7820 and 7810. For details about the [ firmware ] section for eSpace 7870, see the 

relevant configuration file. 

The firmware information is specified by the following fields in the configuration file:  

################################################################## 

[ firmware ] 

path = /tmp/download.cfg 

server_type = http               #Upgrade server type. 

server_ip = 192.168.0.231       #IP address of the upgrade server.  

server_port =                #Port number of the upgrade server.  

login_name =                #User name for logging in to the upgrade server. This field  

can be left blank if no user name is required for login. This field is usually set for FTP servers.  

login_pswd =                 #Password for logging in to the upgrade server.  

http_url = http://192.168.0.231/  #URL of the upgrade server. This field is mandatory only 

when HTTP or HTTPS is used for upgrade. 

firmware_name = 0.0.0.143.rom         #Firmware version number. 

################################################################## 

Downloading Ring Tones 

The ring tone information is specified by the following fields in the configuration file:  

################################################################## 

[ ringtone ] 

path = /tmp/download.cfg 

server_address =     #Path for storing a ring tone file. The ring tone file must be in .wav 

format, and the file size does not exceed 100 KB. 

################################################################## 

Updating the Local PhoneBook 

The local PhoneBook information is specified by the following fields in the configuration file: 

################################################################# 
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[ ContactList ] 

path = /tmp/download.cfg 

server_address =        #Path for storing a local address book. 

################################################################# 

 

 

 The file name of the local phone book must be contactData1.xml. If it is not, update will 

fail. 

 The content format in the local phone book file is different from that in the remote phone 

book file. To configure a local phone book file, access the web configuration page, click 

the Contacts tab, and click Local PhoneBook. Click Export XML to export a local 

phone book file, and modify the file as required. 

The template of local phone book file exported on the web configuration page is delivered 

with the software version and is available at http://support.huawei.com/. 

3.3 Configuring and Upgrading IP Phones in Batches 

 

 

Ensure the power supply of an IP phone during the upgrade. Otherwise, result in upgrade 

failed. 

3.3.1 Preparations for Configuration and Upgrading IP Phones 

To configure and upgrade IP phones in batches during the deployment, prepare the following 

items: 

 Configuration file template 

The configuration template is a .cfg file. You can change the parameter values in the 

template based on the site scenarios. 

 File server 

The HTTP server is used. For details on how to set up the HTTP server environment, see 

5.2 Configuring the HTTP Server. 

 DHCP server 

For details on how to set up the DHCP server environment, see 5.4 Setting Up the DHCP 

Server. 

 DNS server 

A DNS server is required when you use domain names to configure the configuration file 

URL. 
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For details on how to set up the DNS server environment, see 5.3 Guidelines for Setting 

Up the DNS Server. 

 Files that need to be updated 

Prepare the firmware version file, ring tone files, and local phone book files based on 

your site scenario. 

Prepare the firmware version file, ring tone files, and local phone book files based on your 

site scenario. 

Figure 3-2 shows the general network diagram for deployment. 

Figure 3-2 Network diagram 

 

 

3.3.2 Procedure for Configuring and Upgrading IP Phones in 
Batches 

Procedure 

1. Store the phone version files and configuration file in the HTTP server root directory. 

To load ring tones or local phone books, store the files in the HTTP server root directory, 

and set related parameters in the global configuration file.  

2. Change the Option246 parameter value of the DHCP server to the configuration file 

URL.5.5 Setting the Option246 Parameter document describes how to set the Option246 

parameter. 

− The configuration file URL specified by the Option246 parameter has the highest 

priority than other specified URLs. 
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− It is optional to specify the configuration file name. The IP phone will automatically 

search for and download the configuration file mapping its model. 

Table 3-1 describes the Option246 parameter settings. 

Table 3-1 Option 246 parameter settings 

Setting Format Example 

IP http://server IP 

IP:port http://server IP:port 

Domain http://domain 

Domain:port http://domain:port 

 

3. Power on all IP phones. 

After being powered on, a phone obtains the IP address from the DHCP server. Then the 

DHCP server delivers the configuration file URL to the phone using the Option246 

parameter. After receiving the URL, the phone obtains the global configuration file from 

the file server to update the phone configurations, and downloads files such as the 

firmware version file from the URLs specified in the configuration file.  

Verifying the Configuration and Upgrade 

After you complete the preceding procedure, test on certain IP phones to ensure that the IP 

phones run normally. 

Use the following methods to verify that the batch configuration and upgrade are successful:  

 Configuration result 

Access the web configuration page and verify that the configurations are the same as 

those in the configuration file. 

 Upgrade result 

In the standby state, press OK to access the Status GUI, and verify that the version number 

corresponding to Firmware is the same as that of the firmware version file. 

If some phones failed to be configured or upgraded, the possible cause is that too many 

phones send configure and upgrade requests to the server at the same time, and the server 

cannot handle all those requests. You are advised to restart these phones. The phone 

downloads the configuration file and firmware version from the file server during the restart.  



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 4 Troubleshooting 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

97 

 

4 Troubleshooting 

4.1 Fault Locating Methods 

4.1.1 Viewing Debugging Logs 

IP phone logs help users to locate the cause of a fault on an IP phone and learn the operating 

status of an IP phone. The log file can be stored on the server so that maintenance personnel 

can query the logs. The log file can be stored to the computer of a user so that the user can 

query them. 

Configuring the IP phone 

To export a log file to the server, proceed as follows: 

1. Log in to an IP phone's web page, click the Upgrade tab, and click Advanced. 

Log in to eSpace 7870's web page, click the Phone tab, and click Configuration. 

2. Select Server from the Export System Log drop-down list box, and enter the system log 

server address, as shown in Figure 4-1. 

Figure 4-1 Setting the Export System Log parameter 

 

 

3. Click Confirm. 

The IP phone automatically restarts, and the settings take effect. 

Configuring the log server 

You must configure the log server before exporting log files to the server. A common file 

server can function as a log server and 3CDaemon is recommended. To configure a log server, 

proceed as follows: 

1. Double-click 3CDaemon.EXE. 

2. Start the log server, click Syslog Server and click Configure Syslog Server. 
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The 3CDaemon Configuration page is displayed, as shown in Figure 4-2. 

Figure 4-2 Setting the log storage path 

 

 

3. Click the Syslog Configuration tab. 

4. On the Syslog Configuration tab page, click  corresponding to Directory for, and 

select the path for saving logs. 

5. Access the specified path and verify that the syslog.log file exists. 

If the file exists in the directory, the log server is configured successfully. 

Viewing logs 

After the IP phone and server are configured, you can view log files in the path specified by 

Directory for when the server is running. Figure 4-3 shows an example of a log file. 

Figure 4-3 An example of a log file 
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Exporting a Log File to the Local Computer 

To export a log file to the local computer, proceed as follows: 

1. Log in to an IP phone's web page, click the Upgrade tab, and click Advanced. 

2. Select Local from the Export System Log drop-down list box, as shown in Figure 4-4. 

Figure 4-4 Exporting a log file to the local computer 

 

 

3. Click Export. 

4. Select a path for storing the exported log file. 

After the syslog.tar log file is exported, view the file in the specified path. Figure 4-5 shows 

an example of the syslog.tar file. 

Figure 4-5 An example of the syslog.tar log file 

 

 

Exporting Network Packets to the Local Computer 

 

 

The size of network packets to export cannot exceed 500 KB. If the size exceeds 500 KB, the 

export fails. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 4 Troubleshooting 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

100 

 

To export network packets to a local computer, proceed as follows: 

1. Log in to an IP phone's web page, click the Upgrade tab, and click Advanced. 

Log in to eSpace 7870's web page, click the Phone tab, and click Upgrade. 

2. Click Start in the PCAP Trace area, as shown in Figure 4-6. 

Figure 4-6 PCAP Trace area 

 

 

3. Click Stop. 

4. Click Export. 

5. Select the path for saving captured network packets. 

Use Wireshark to open a captured network packet and view packet information, as shown in 

Figure 4-7. 
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Figure 4-7 Viewing a captured network packet 

 

 

4.1.2 Using a Packet Capture Tool to Capture Packets 

Connect an IP phone's network port and a computer to the same hub, and use the packet 

capture software such as the Sniffer, Ethereal, or Wireshark to capture packets.  

You can locate faults quickly by analyzing the captured packets. Use Wireshark 4.1.3 to 

capture and analyze packets. 

For details on how to capture and analyze packets, see 5.6 Capturing Packets Through the 

Packet Capture Tool 

4.1.3 How to Obtain Device Information by Observing the Status 
Indicators and LCD 

Status Indicators 

Indicators on eSpace 7870, 7850, 7830, 7820 and 7810 include the power supply indicator, 

message status indicator, account indicator, headset indicator(7810&7820 only have headset 

key), SCA indicator, and BLF indicator. Table 4-1 lists the status indicators. 
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Table 4-1 Status indicators 

Indicator Color Status Description 

Power 

supply 

Green Steady on The power supply is connected 

properly. 

Blinking The IP phone receives a call, or a 

call is being muted. 

Steady off The power supply is disconnected. 

Message 

status 

indicator 

Green Steady on There are new messages to the IP 

phone. 

Steady off There is no message to the IP 

phone. 

Headset 

status 

indicator 

Green Steady on A headset is used. 

Steady off No headset is used. 

Account 

indicator 

Green Steady on The account is occupied. 

Blinking The account receives or holds a 

call. 

Steady off The phone is in the on-hook state. 

Line key 

assigned the 

SCA 

function 

Green Steady on The listened-on account is in the 

idle state. 

  Blinking The listened-on account is in the 

occupied state. 

  Steady off The SCA function is disabled. 

Line key 

assigned the 

BLF 

function 

Green Steady on The listened-on account is in the 

idle state. 

Blinking The listened-on account is in the 

occupied state. 

Steady off The BLF function is disabled. 

Memory 

key 

assigned the 

BLF 

function 

Green Steady on The listened-on account is in the 

idle state. 

Red Steady on The listened-on account is in the 

talking state. 

Blinking The listened-on account is in the 

ringing state. 

Green/Red/Orange Steady off The BLF function is disabled. 
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4.1.4 Icons 

Table 4-2 lists icons that may occur on the eSpace 7850&7830&7810 screen. 

Table 4-2 Icons on the eSpace 7850&7830&7820&7810 screen 

No. Icon Description 

1 
 

This icon blinks when network connection failed. 

2  or  Indicates that an account failed to be registered. 

3  Indicates that an account is being registered. 

4  or  Indicates that an account is registered successfully. 

5 
 or 

 

Indicates a missed call. 

6  Indicates an incoming call. 

7  Indicates an outgoing call. 

8  Indicates all input methods. 

To switch input methods, press the key corresponding to this 

icon. 

9  Indicates digital input. 

10  Indicates lower-case input. 

11  Indicates upper-case input. 

12 
 

Indicates that a call is muted. 

13  Indicates that a call is held. 

14  Indicates a voice message.  

15  Indicates that the call forward function is enabled. 

16  Indicates that the DND function is enabled. 

17  Indicates that the auto answer function is enabled. 

18  Indicates the handset mode. 

19  Indicates the headset mode. 

20  Indicates the handsfree mode. 

 

Table 4-3 lists icons that may occur on the eSpace 7870 screen. 
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Table 4-3 Icons on the eSpace 7870 screen 

No. Icon Description 

1 
 

This icon blinks when network connection failed. 

2 
 

Indicates that an account failed to be registered. 

3 
 

Indicates that an account is being registered. 

4 
 

Indicates that an account is registered successfully. 

5 
 

Indicates a missed call. 

6 
 

Indicates an incoming call. 

7 
 

Indicates an outgoing call. 

8 
 

Indicates a missed call. 

9 2aB Indicates all input methods. 

To switch input methods, press the key corresponding to this 

icon. 

10 123 Indicates digital input. 

11 abc Indicates lower-case input. 

12 ABC Indicates upper-case input. 

13 
 

Indicates that a call is muted. 

14 
 

Indicates that a call is held. 

15 
 

Indicates a voice mailbox. 

16 
 

Indicates that the call forward function is enabled. 

17 
 

Indicates that the DND function is enabled. 

18 
 

Indicates that the auto answer function is enabled. 

19 
 

Indicates the handset mode. 

20 
 

Indicates the headset mode. 

21 
 

Indicates the hand-free mode. 

22 
 

Indicates that the volume is 0. 

23 
 

Indicates that the recording function fails to be enabled. 

24 
 

Indicates that the recording function fails to be disabled. 
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No. Icon Description 

25 
 

Indicates that the recording memory is full. 

26 
 

Indicates that recording fails. 

27 
 

Indicates that recording is ongoing. 

28 
 

Indicates that the VPN function is started. 

29 
 

Indicates the keyboard lock mode. 

30 
 

Indicates that there is an ongoing conference. 

31 
 

Indicates the image of a called party. 

 

Table 4-4lists the icons corresponding to the functions that are specified for account indicators. 

The icons are displayed on eSpace 7870's screen. 

Table 4-4 Icons corresponding to the functions that are specified for account indicators 

No

. Icon Description 

1 
 

Indicates that an account indicator is set to implement a function other than 

line indicator, BLF, speed dial, or remote group. 

2 
 

Indicates that an account indicator is set as the BLF indicator, but the setting 

fails. 

3 
 

Indicates that an account indicator is set as the BLF indicator and the 

listened-on account is idle. 

4 
 

Indicates that an account indicator is set as the BLF indicator and the 

listened-on account is in the ringing state. 

5 
 

Indicates that an account indicator is set as the BLF indicator and the 

listened-on account is in the talking state. 

6 
 

Indicates that an account indicator is set to implement the speed dial function. 

7 
 

Indicates that an account indicator is set to implement the remote group 

function. 
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4.2 Common Faults and Fault Analysis 

4.2.1 How to Obtain the MAC Address When the IP Phone Is 
Powered Off 

You can obtain the MAC address in any of the following ways: 

 The MAC address of an IP phone is pasted in the rear of the IP phone. 

 According to the corresponding PO, you can ask the provider to provide the delivery 

information table that contains the MAC address. 

 MAC addresses of all the IP phones are listed in the label on the large package box of the 

IP phone. 

 The MAC address of an IP phone is pasted on the small package box of the IP phone.  

4.2.2 An IP Phone Cannot Obtain an IP Address 

Symptom 

The icon  and the message "Network Unavailable" are displayed. 

Cause 
 A network cable is connected to the PC port of the IP phone. 

 The network cable is disconnected from the IP phone. 

 The network cable is damaged. 

 Network parameter settings are incorrect, for example, the static IP address is 

unavailable. 

 The network connection is abnormal. 

Troubleshooting 
 Verify that the network cable is connected to the network port. 

 Verify that the network cable is intact and the connection is normal. 

 Verify that network parameters such as IP addresses are correct. 

 Verify that the network connection is normal. For example, the DHCP server is running 

properly and has available IP addresses, and DHCP servers do not conflict in a LAN. 

4.2.3 IP Addresses of an IP Phone and Another Device Conflict 

Symptom 

The message "IP conflict" is displayed on an IP phone's LCD. 

Cause 

The static IP address of an IP phone conflicts with the IP address assigned by the DHCP 

server. 
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Troubleshooting 

Set the IP address of the IP phone to an available value. 

4.2.4 IP Phone Can Make Calls But Cannot Receive Calls 

Symptom 

An IP phone can make calls but cannot receive calls. 

Cause 

When the DND function is enabled, incoming calls are rejected. 

Troubleshooting 

If the DND icon is displayed on the IP phone's LCD, the DND function is enabled. 

When eSpace 7810 is in the standby state, press the Menu soft key, select Features, and press 

Enter. Then select DND and press Enter. Press the left or right arrow key to select Disabled, 

and press the OK key. 

When eSpace 7870, eSpace 7850, eSpace 7830 and eSpace 7820 is in the standby state, press 

the DND soft key to disable the DND function.  

4.2.5 IP Phone Cannot Make and Receive Calls 

Symptom 
 The message "No service" is displayed on an IP phone's LCD. 

 The  or  icon is displayed on an IP phone's LCD. 

 When an IP phone's circuit board is changed, the blank screen (eSpace 7820/eSpace 

7830/eSpace 7850) or full-screen characters (eSpace 7810) or red screen (eSpace 7870) 

are displayed, and the account indicator and message indicator are blinking (eSpace 

7810/ eSpace 7820/eSpace 7830). Then the page is displayed normally and accounts can 

be registered, but the IP phone cannot make or receive calls. 

Cause 
 No account is registered. 

 Account registration fails. 

 The MAC address is not burned or an incorrect MAC address is burned after the circuit 

board is changed in the IP phone. 

Troubleshooting 
 Verify that an account has been registered. 

 Verify that account information is correct and complete. 

 Use a burning tool to burn the MAC address listed in the label on the rear of the IP phone 

to the new circuit board. 
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4.2.6 Causes of Crosstalk 

 The MAC address of the IP phone conflicts, which has a small possibility. 

 Sessions are not synchronized to the lower-level NAT and firewall when the SBC is 

used. 

4.2.7 An IP Phone Rings but You Cannot Hear the Peer End When 
Picking Up the IP Phone 

Symptom 

An IP phone rings when receiving a call, but you cannot hear the peer end when picking up 

the IP phone. 

Cause 

This fault occurs when signaling messages can be transmitted but media streams cannot be 

transmitted. Signaling messages are transmitted by a server and media streams are transmitted 

from end to end. 

In the case of unidirectional communication on the IP Phone network, you can make a call on 

a specified trunk circuit to locate the cause (upper-level office fault or internal office fault).  

If no fault is found on all the trunk circuits, check the internal office fault. In the case of 

unidirectional communication in the internal office, you can use the packet capture tool to 

analyze whether the network setting is correct. The internal office fault may be the hardware 

or software fault. 

 Hardware faults can be often detected. A fault occurs in an office direction or a fault 

often occurs. To locate a hardware fault, attempt to replace the hardware for testing, such 

as switching the MCU and replacing the trunk board or terminal. The overall principle is 

to trace the call where a fault occurs, make a summary of fault occurrence, eliminate 

possible causes one by one, and locate the actual cause. 

 To locate a software fault, trace the call information when the fault occurs step by step 

and describe the scenario and recurrence conditions. Then send the information to the 

R&D personnel for further analysis. 

Troubleshooting 
 Media streams cannot be transmitted. 

 The IP phone or headset is connected to an incorrect port. The headset ports of eSpace 

7810, 7820, 7830, 7850 and 7870 use RJ-9 and the IP phone ports also adopt RJ-9. 

 If RTP encryption is enabled on an IP phone but encryption is disabled on the peer end, 

unidirectional communication may occur. Verify that RTP encryption is enabled or 

disabled both on the two ends. 

4.2.8 An IP Phone Cannot Obtain Time Information from the NTP 
Server 

Symptom 

When a computer functions as the NTP server, the IP phone cannot obtain time information.  



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 4 Troubleshooting 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

109 

 

Cause 

The firewall is installed on the computer; therefore, NTP packets sent by the IP phone are 

intercepted. 

Troubleshooting 

You can use either of the following methods to rectify the fault: 

 Disable the firewall on the computer. 

 Add a rule, which allows NTP packets to pass through the firewall. In the Add a Port 

dialog box, set Port number to 123 (a port number frequently used by the NTP server), 

select UDP, and set Name to any value, as shown in Figure 4-8. 

Figure 4-8 Add a Port dialog box 

 

 

4.2.9 Voices on an IP Phone Are Intermittent 

Symptom 

Voices on an IP phone are intermittent. 

Cause 

This fault is caused by packet loss or jitter. 

 Packet loss is caused by network congestion or insufficient device capabilities. 

 Jitter is caused by packet assembling on the transmitting device or receiving device, such 

as the timeout processing, retransmission mechanism, and insufficient buffer. 

Troubleshooting 
 Improve the network quality. 
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 Change the IP phone codec. Generally, the default codec of an IP phone is G.711A. If the 

network quality is low, you can set the codec to G.729 or G.723. 

4.2.10 Failed to Upgrade an IP Phone 

Symptom 

After an IP phone is upgraded, its firmware version does not change. 

Cause 
 The target firmware version is the same as the source firmware version. 

 The target firmware version does not match the phone model. 

 The source firmware or target firmware is protected by software. 

Troubleshooting 

Select a correct version to upgrade. The version formats for different IP phone models are as 

follows: 

 For eSpace 7870, the version format is 38.x.x.x. 

 For eSpace 7850, the version format is 2.x.x.x. 

 For eSpace 7830, the version format is 6.x.x.x. 

 For eSpace 7820, the version format is 7.x.x.x. 

 For eSpace 7810, the version format is 9.x.x.x. 
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5 Appendix 

5.1 Configuring the TFTP Server (3CDaemon TFTP Server 
for Example) 

 
The TFTP server does not need to be installed. Download the TFTP server from the official website. 

1. Start the TFTP server, as shown in Figure 5-1. 

Figure 5-1 TFTP server main page 

 

 

2. Click Configure TFTP Server under TFTP Server. 

A dialog box is displayed, as shown in Figure 5-2. 
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Figure 5-2 3CDaemon Configuration dialog box 

 

 

3. Click the TFTP Configuration tab. On the tab page, click the  button corresponding 

to Upload/Download, and select a directory for storing uploaded files, as show in Figure 

5-3. 
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Figure 5-3 Selecting a directory for storing uploaded files 

 

 

5.2 Configuring the HTTP Server 

5.2.1 Using the Windows IIS Component 

The Windows Internet Information Service (IIS) component can be used to configure the 

HTTP server. Before the configuration, obtain the Windows operating system installation 

CD-ROM or the installation package URL and then install the IIS component. 

To install the IIS component in the Windows XP operating system, proceed as follows: 

1. Choose Start > Control Panel. 

The Control Panel window is displayed.  

2. Double-click Add or Remove Programs. 

The Add or Remove Programs window is displayed, as shown in Figure 5-4. 
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Figure 5-4 Add or Remove Programs window 

 

 

3. Click Add/Remove Windows Components in the left pane. 

The Windows Components Wizard window is displayed, as shown in Figure 5-5. 
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Figure 5-5 Windows Components Wizard window 

 

 

4. Select the Internet Information Services (IIS) check box in the Components area and 

click Next. 

The system displays a window asking you to insert the installation CD-ROM before the 

installation is started, as shown in Figure 5-6. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 5 Appendix 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

116 

 

Figure 5-6 Insert Disk dialog box 

 

 

5. Insert the installation CD-ROM, and click OK. 

The Files Needed dialog box is displayed, as shown in Figure 5-7. 

Figure 5-7 Files Needed dialog box 

 

 

6. Click Browse and set Copy files from to G:\i386. 

7. Click OK. 

The system starts copying the files and installing the component, as shown in Figure 5-8. 
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Figure 5-8 Configuring Components dialog box 

 

 

After the installation is complete, the dialog box automatically exits. You can check for 

the IIS component in Control Panel. 

8. After the installation is complete, store the phone version files and configuration file in 

the root directory C:\Inetpub\wwwroot. 

5.2.2 Apache Server 

The Windows Internet Information Service (IIS) component also functions as an HTTP server 

to provide required files for IP phones. You can obtain the Apache HTTP server software at 

http://httpd.apache.org and install the Apache server based on the installation wizard. 

Assume that Apache HTTP Server2.2 has been installed in the Windows XP operating system. 

Perform the following steps to start the Apache Server and place the required files: 

1. Start the Apache server. Choose Start > All Programs > Apache HTTP Server 2.2 > 

Monitor Apache Servers. 

If icon  is shown on the taskbar, the Apache server has been started. If icon  is 

shown on the task bar, right-click the icon and choose Start from the shortcut menu. 

2. Place the required files in the installation path, for example, \Apache Software 

Foundation\Apache2.2\htdocs. 

 
If the required files are placed directly in the htdocs folder, type the address in the format of http://IP 

address of the PC where the Apache server is installed to access the Apache server, for example, 

http://10.10.10.9:8088/serviceagent http://192.169.1.51. 
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If the required files are placed under a subfolder of the htdocs folder, type the address in the format of 

http://IP address of the PC where the Apache server is installed/subfolder name to access the Apache 

server, for example, http://192.169.1.51/filename. 

5.3 Guidelines for Setting Up the DNS Server 
This document takes the DNS Server preinstalled in the Window 2003 Server for example to 

describe the procedure for setting up the DNS server. 

Starting the DNS Service 

Choose Start > Programs  > Administrative Tools > DNS . 

 

 

If the DNS service is not installed on the PC, install the DNS component firstly. 

Creating a Zone 

To create a zone, do as follows: 

1. Right click Forward Lookup Zones, and then choose New Zone to start New Zone 

Wizard. 

 

2. Click Next, and then select Primary zone to create a primary zone. 
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3. Select an option for Select how you want zone data replicated, and click Next. 

 

4. Enter the name of the DNS zone, for example, huawei.com. Then click Next. 
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5. Select a dynamic update type, and then click Next. 

 

6. After the zone is created, click Finish. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 5 Appendix 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

121 

 

 

7. A new zone is displayed. 

 

8. Click the zone to display the resource records in detail. You can find that each zone has 

records Start of Authority (SOA) and Name Server (NS), which can be used to 

determine your DNS server. The SOA indicates the account name that is used. 

Creating a Record of Type A 

A record of Type A provides the mapping between standard host names and IP addresses. In 

the following figure, Name indicates the host name and the value is the IP address of the host. 

For example, {relay1.bar.foo com,145.37.93.126,A} is a record of Type A. 

To create a record of Type A, do as follows: 
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1. Right-click Huawei.com and choose New Host(A). After setting the host name and IP 

address, click Add Host. 

 

2. Repeat the preceding operation to create multiple records of Type A. 

5.4 Setting Up the DHCP Server 

5.4.1 Setting Up the DHCP Server in the Window 2003 Server 

Basics Concepts 

The Dynamic Host Configuration Protocol (DHCP) is mainly used to allocate dynamic IP 

addresses to terminals on the same network. When DHCP is used, a DHCP server needs to be 

deployed on the network and IP phones function as DHCP clients. 

When a DHCP client sends a request for a dynamic IP address, the DHCP server provides an 

available IP address and subnet mask for the DHCP client according to the preserved IP 

address set. 

The DHCP has two port numbers, that is, port 67 for the DHCP server and port 68 for the 

DHCP client. This means that the DHCP client selects only port 68, rather than a temporary 

port that is not used. 

Here, the two ports are selected because a response from the DHCP server can be broadcast. 

The following figure shows the process for an IP phone to obtain the IP address through 

DHCP. 
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Installing the DHCP Service 

Generally, the DHCP service component is installed by default during the installation of the 

Window 2003 Server. If the DHCP service component is already installed, go to Starting the 

DHCP Service and Setting DHCP Parameters. If the DHCP service component is not installed, 

do as follows to install it: 

1. Choose Start > Settings > Control Panel, click Add or Remove Programs, and click 

Add/Remove Windows Components. 

The Windows Components Wizard dialog box is displayed. 
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2. Select Networking Services, and click Details to display the Networking Services 

dialog box. 

 

3. Select the DHCP service and click OK to exit the page of network service. Click Next 

repeatedly until the installation is complete. After the installation is successful, the dialog 

box shown in the following figure is displayed. 
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Starting the DHCP Service and Setting DHCP Parameters 

After the DHCP service component is installed, do as follows to start the DHCP service: 

1. Choose Start > Programs > Administrative Tools > Manage Your Server. 

2. In the Manage Your Server dialog box that is displayed, select Manage this DHCP 

server. 
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3. Enter the main page of the DHCP, as shown in the following figure. 

 

4. Right-click DHCP and choose Add Server. 

The Add Server dialog box is displayed. 
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5. Step 5 Set the name of the DHCP server randomly, and then click OK. If the setting is 

successful, the page shown in the following figure is displayed. 

 

6. Right-click Huawei[10.10.10.2] and choose New Scope. In the New Scope Wizard 

dialog box that is displayed, click Next. 

A dialog box is displayed, as shown in the following figure. 
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7. Set the name of the new function domain randomly, and then click Next. 

The following dialog box is displayed. 

 

8. In the preceding dialog box, set the start and end IP addresses provided by the DHCP 

server, and set the subnet mask. Then click Next repeatedly until the Lease Duration 

dialog box is displayed, as shown in the following figure. 
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9. In the Lease Duration dialog box, you can set the lease period of the DHCP server. By 

default, the lease period of the DHCP server is eight days. After the setting, click Next 

repeatedly until the Router(Default Gateway) dialog box is displayed, as shown in the 

following figure. 

 

10. Set the gateway address provided by the DHCP server. When an IP phone obtains the IP 

address from the DHCP server, the DHCP server provides the IP address and gateway 
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address for the IP phone. After the setting is complete, click Next repeatedly until the 

setting is complete. Then the page shown in the following figure is displayed. You can 

view the IP address pool information on it. 

 

After the setting is complete, if some IP phones are set to obtain IP addresses through DHCP, 

the DHCP server allocates the IP addresses in the IP address pool to the IP phones one by one. 

If the lease of IP addresses is not renewed, the DHCP server withdraws the IP addresses for 

use of other devices. 

5.4.2 Setting Up the DHCP Server on Router AR-28 

The configuration scripts and remarks for logging in to router AR-28 and enabling the DHCP 

server function are as follows: 

<Quidway>system-view                 //Enter the configuration mode.  

[Quidway]dhcp enable                  //Enable the DHCP server function of the 

router.  

[Quidway]dhcp server detect           //Verify the DHCP server function.  

[Quidway]interface Ethernet 0/1       //Connect to network port 1 on board 0.  

 

 
You must make sure that the network cable is inserted into network port 1 of board 0 on router AR-28. 

In the rear panel of the router, you can view the board slots and enable DHCP function on network port 

1. 

[Quidway-Ethernet0/1]ip address 192.168.2.1 255.255.255.0   //Set the IP 

address of network port 0/1. The router also uses the IP address as the gateway 

address and allocates the IP address to the DHCP client.  

[Quidway-Ethernet0/1]dhcp select interface          //If the DHCP server mode 

is selected based on the interface, the router can also set the DHCP server 
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based on other modes.  

[Quidway-Ethernet0/1]dhcp server dns-list 192.168.2.20   //Set the DNS server 

IP address delivered to the DHCP client when the DHCP server delivers an IP 

address to the DHCP client. The DNS server IP address is optional.  

[Quidway-Ethernet0/1]dhcp server option ****   //Set the DHCP options as 

required.  

[Quidway-Ethernet0/1]dhcp server expired ****  //Set the DHCP lease period. 

You can set to unlimited or several days. The maximum lease period is 365 days. 

The default lease period is 24 hours.  

[Quidway-Ethernet0/1]quit      //Return to the configuration mode.  

[Quidway]quit     //Exit the configuration mode.  

<Quidway>save   //Save the setting.  

 

After the setting is complete, save the setting. Otherwise, the data is lost after restart. 

 
In the preceding scripts, *** indicates the parameters followed. The parameter names can be set 

according to the actual situation. For which parameter names can be set, press Shift + ?. 

5.5 Setting the Option246 Parameter 

This document describes how to set the Option246 parameter. 

Procedure 

1. Choose Start > Administrative Tools > DHCP. 

The DHCP window is displayed. 

2. Click  on the left pane to expand the navigation tree, as shown in Figure 5-9. 
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Figure 5-9 DHCP window 

 

 

3. Right-click the record framed in red in Figure 5-9 and choose Configure the Predefined 

Options from the shortcut menu. 

The Predefined Options and Values dialog box is displayed, as shown in Figure 5-10. 
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Figure 5-10 Predefined Options and Values dialog box 

 

 

4. Click Add. 

The Option Type dialog box is displayed, as shown in Figure 5-11. 

Figure 5-11 Option Type dialog box 

 

 

5. Set related parameters according to Table 5-1. 

Table 5-1 Parameter settings 

Parameter Example 

Name ip phone 
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Parameter Example 

Data type String 

Code 246 

Description ip phone auto provision 

 

6. Click OK. 

The system returns to the Predefined Options and Values dialog box. 

7. Click OK. 

The system returns to the DHCP window. 

8. Select and right-click Server Options in the navigation tree and choose Configure the 

Options from the shortcut menu. 

The Server Options dialog box is displayed. 

9. Select the 246 ip_phone check box under Available Options, as shown in Figure 5-12. 

Figure 5-12 Server Options 

 

 

10. Set String value in the Data entry area. 

For example, set it to http://10.1.1.10 
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11. Click OK. 

The server information is displayed in the DHCP window. 

5.6 Using Windows 2003 Server AD 

5.6.1 Installing Windows 2003 Server AD 

Step 1 Insert the Service Pack 2 CD-ROM to CD-ROM drive of a PC running Windows 2003 Server. 

Step 2 Choose Start > Run in Windows 2003 Server, enter dcpromo, and click OK.  

The Active Directory Installation Wizard page is displayed.  

Step 3 Click Next. 

 

 

Step 4 Click Next. 
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Step 5 Select Domain controller for a new domain to specify the local PC running Windows 2003 

Server as the domain controller (DC). 

 

 

Step 6 Select Domain in a new forest, and click Next. 
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Step 7 Enter test.com as the new domain name, and click Next. 

 

 

Step 8 Retain the default value TEST as the Domain NetBIOS name, and click Next. 
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Step 9 Retain the default values of paths for saving database and log folders, and click Next. 

 

 

Step 10 Retain the default path for saving the folder to be shared as the system volume, and click 

Next. 
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Step 11 Diagnose DNS registration.  

DNS service components are not installed on the PC running Windows 2003 Server so the 

diagnosis fails. 

Step 12 Select Install and configure the DNS server on this computer, and set this computer to 

use this DNS server as its preferred DNS server, and click Next. 
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Step 13 Retain the default value when setting default permissions for users and group objects, and 

click Next. 

 

 

Step 14 Set the administrator password for the restore mode, for example, 123456, and click Next. 

 

 

Step 15 Verify the configurations and click Next. 
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Step 16 Wait for the AD to be installed and configured. 

 

 

Step 17 Click Finish after the AD is installed. 
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Step 18 Click Restart to make the settings take effect. 

 

 

5.6.2 Creating a Domain User 

Step 1 Choose Start > Program > Administrative Tools > Active Directory Users and Computer. 
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Step 2 Right-click User and choose New > User. 

 

 

Step 3 Create a login user account dongle. 
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Step 4 Create a password (Huawei123) for the dongle user, and select User cannot change 

password. Click Next. 

 

 

Step 5 The login user account dongle is created.  

Step 6 Click Finish. 
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Step 7 Double-click the dongle user's avatar and set the user's phone number and other information. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 5 Appendix 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

146 

 

 

 

5.7 Capturing Packets Through the Packet Capture Tool 

You can connect the LAN interface of an IP phone and a computer to the same hub, and use 

the packet capture software such as the Sniffer, Ethereal, or Wireshark to capture packets. 

Alternatively, you can configure mirroring on the interface connected to the IP phone. You 

can locate faults quickly by analyzing the captured packets. You are advised to use the 

Wireshark-0.99.6a software to capture and analyze packets. 

For details on how to capture and analyze packets, see the following document:  

Packet Capture Setting 

Generally, you do not need to perform special setting before using Wireshark to capture and 

analyze packets. To modify settings, do as follows: 

1. Select Preferences on the Edit menu. 
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Figure 5-13 Setting parameters on the Preferences dialog box 

 

 

2. Set parameters on the displayed Preferences dialog box according to the actual situation. 

3. Choose Capture to modify the packet capture setting. 

On the Capture dialog box, you can specify the network adapter where packets need to 

be captured, and determine whether to capture packets in promiscuous mode. (capture all 

the packets passing through the network adapter, whether to update packets in real time, 

whether to scroll packets automatically, and whether to hide the packet capture dialog 

box.) 

Figure 5-14 Setting on the Capture dialog box 

 

 

4. Click Edit to change the interface properties.  
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You are advised to hide Adapter for generic dialup and VPN capture; otherwise, 

packets cannot be captured because the interface is set to the default one. Operation 

procedure: Choose Adapter for generic dialup and VPN capture and select Hide 

interface. 

Figure 5-15 Setting on the Interface Options page 

 

 

5. If multiple network adapters are available, you are advised to add a comment to each 

network adapter so that you can distinguish the network adapter where packets are 

captured. Operation procedure: Choose the network adapter to be modified and add the 

contents in the Comment text box. 

Figure 5-16 Adding contents to the Comment text box 

 

 

6. Choose Printing to modify the printing setting. 

You can select File or Printer in Print to. The format can be plain text or postscript. 

Generally, the format is plain text. 
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Figure 5-17 Setting on the Printing page 

 

 

Methods of Capturing Packets 

You can use the Wireshark to start capturing packets from multiple ingresses. The details are 

as follows. 

 Capturing Packets Directly 

You can start capturing packets directly. That is, you use the default setting without 

setting packet capture options. You can use either of the following methods: 

1. Click Start button the toolbar to start capturing packets, as shown in Figure 5-18 

Figure 5-18 Starting capturing packets through the toolbar 

 

 

2. Choose Capture > Start>, as shown in Figure 5-19. 
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Figure 5-19 Capturing packets through the menu 

 

 

 Capturing Packets by Specifying an Interface 

You need to select an interface, and then start capturing packets. 

You can set options after opening the Capture Interfaces dialog box. The method is as 

follows: Select Interfaces from the Capture menu and open the Capture Interfaces 

dialog box, as shown in Figure 5-20. 

Figure 5-20 Selecting an interface for capturing packets 

 

 

Figure 5-21 Capture Interfaces dialog box 

 

 

You can start capturing packets by clicking Start corresponding to the interface. You can 

click Options to modify the option setting, and then start capturing packets. See the 

following steps. 

1. Set options for capturing packets. 
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Figure 5-22 Selecting Options 

 

 

2. On the Capture Options dialog box, you need to select the network adapter where 

packets need to be captured to filter out packets. You need to capture packets in 

promiscuous mode and automatically updating and scrolling packets in packet capture, 

as shown in Figure 5-23. 

Figure 5-23 Setting packet capture options 

 

 

Sometimes you need to capture packets cyclically or capture packets with the fixed size 

(for example, capture packets of 10 M, and then stop capturing packets), or capture 

packets with a fixed interval (stop capturing packets after capturing packets for 10 

minutes). You can set related options in capture File(s). 
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Before capturing packets, you can filter packets. The expression used to filter packets is 

host<IP address>.Only the packets with the specified IP address are captured. Common 

expressions used to filter packets are as follows: 

[src|dst] host <host>  

ether [src|dst] host <ehost>  

gateway host <host>  

[src|dst] net <net>[{mask <mask>}|{len <len>}]   

[tcp|udp] [src|dst] port <port>  

less|greater <length>  

ip|ether proto <protocol>  

ether|ip broadcast|multicast   

<expr>relop<expr> 

Packet Analysis 

1. Packet Filtering 

In actual applications, there is a large amount of data in packet capture. To rapidly locate 

the required packets, you need to use the packet filtering function. 

To filter packets, enter the expression in the Filter text box and click Apply. For 

example, to filter TCP packets, enter tcp in the Filter text box and click Apply. 

Figure 5-24 Packets that are not filtered 
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Figure 5-25 Filtered packets 

 

 

In addition to entering the expression manually, you can use other shortcut methods. On 

the Packet List window, right-click the source or destination address of any packet and 

choose Apply as Filter > Selected, as shown in Figure 5-26.Figure 5-27 shows the 

filtering effect. 

Figure 5-26 Filtering packets (1) 
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Figure 5-27 Filtering packets (2) 

 

 

This filtering method is simple. In addition to the Packet List window, you can use the 

similar method on the Packet Details window. 

2. Decoding 

Generally, the Wireshark uses the port number to parse application layer protocols. If 

applications do not use standard port numbers or default port numbers of application 

layer protocols, the Wireshark cannot parse the application layer protocols. Instead, it 

can parse only transport layer protocols (TCP or UDP). 

For example, the Web application using HTTP uses port 80 as the default port number. If 

an application uses port 80, the application layer HTTP in the captured packets is parsed 

by the Wireshark. Otherwise, TCP in the packets is parsed. 

The default port of the application that uses RTSP for communication is port 554; 

therefore; the packets containing port 554 are RSTP packets, as shown in .  
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Figure 5-28 Parsing RTSP packets 

 

 

If the Web application does not use port 80, for example, port 8082, HTTP cannot be 

parsed. It is difficult to analyze the captured packets. 

Figure 5-29 Packet whose HTTP is not parsed 

 

 

To analyze packets easily, you can use the encoding function of the Wireshark to parse 

the HTTP protocol. The packet whose HTTP is parsed is as follows. 
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Figure 5-30 Packet whose HTTP is parsed 

 

 

The steps are as follows: 

a. Right-click any packet containing port 8082 and select Decode As…. 

Figure 5-31 Parsing packet a through the non-standard HTTP port 

 

 

b. On the displayed Decode As dialog box, click Decode, select both in TCP on the 

Transport page, and set the parsing protocol to HTTP.  
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Figure 5-32 Parsing packet b through the standard HTTP port 

 

 

c. After the options are set, click OK.  

To remove the customized decoding mode, click Do not decode on the Decode As 

dialog box.  

3. Follow TCP Stream 

To analyze data flows based on TCP, you can use the Follow TCP Stream function of the 

Wireshark. This function allows you to analyze the exchange process of data flows.  

On the Packet List window, choose any packet and right-click to choose Follow TCP 

streams, as shown in Figure 5-33. 

Figure 5-33 Follow TCP Stream 
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Figure 5-34shows the operation result from which you can view the detailed exchange 

process and data. 

Figure 5-34 Operation result 

 

 

Statistics Function 
 Summary Information 

The Wireshark provides powerful statistics functions, including the statistics on the 

summary of the traffic.  

Choose Statistics > Summary, and you can view the summary of the traffic. On the 

Summary page, the statistics on all the packets can be displayed or the statistics on the 

packets matching a filtering condition can be displayed. 
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Figure 5-35 Statistics function 

 

 

 Call Process 

When using the Wireshark to analyze packets, you can choose Statistics > Flow Graph 

to learn the exchange process of each component. 

Figure 5-36 Flow Graph 

 

 

After choosing Flow Graph, a dialog box is displayed. After performing the setting as 

required, click OK to display the Graph Analysis dialog box. 
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Figure 5-37 Graph Analysis dialog box 

 

 

To use the preceding figure in other documents, you can copy the screenshot or click 

Save as to save the figure as the flowchart in text format. The format is as follows: 

|Time     | Sunniwel_05:0e:2c | Broadcast   | HuaweiTe_d3:48:c0 | HuaweiTe_c4:da:96 

|   

|0.000    |         Active Discovery Te     |                   |                   |   

|         |(0)      ------------------>  (0)|                   |                   |   

|2.711    |         Active Discovery In     |                   |                   |   

|         |(0)      ------------------>  (0)|                   |                   |   

|2.730    |         Active Discovery Of     |                   |                   |   

|         |(0)      <--------------------------------  (0)      |                   |   

|2.730    |         Active Discovery Of     |                   |                   |   

|         |(0)      <----------------------------------------------------  (0)      

|   

|2.731    |         Active Discovery Re     |                   |                   |   

|         |(0)      -------------------------------->  (0)      |                   |   

|2.750    |         Active Discovery Se     |                   |                   |   

|         |(0)      <--------------------------------  (0)      |                   |   

|2.758    |         Configuration Reque     |                   |                   |   

|         |(0)      -------------------------------->  (0)      |                   |   

|2.769    |         Configuration Ack       |                   |                   |   

|         |(0)      <--------------------------------  (0)      |                   |   

|5.739    |         Configuration Reque     |                   |                   |   

|         |(0)      <--------------------------------  (0)      |                   |   

|5.740    |         Configuration Ack       |                   |                   |   

|         |(0)      -------------------------------->  (0)      |                   |   

|5.740    |         Echo Request            |                   |                   |   

|         |(0)      -------------------------------->  (0)      |                   |   

|5.750    |         Challenge |             |                   |                   |   

|         |(0)      <--------------------------------  (0)      |                   |   

|5.751    |         Response  |             |                   |                   |   

|         |(0)      -------------------------------->  (0)      |                   |   

|5.760    |         Echo Reply|             |                   |                   |   

|         |(0)      <--------------------------------  (0)      |                   |   

|5.767    |         Success (MESSAGE='A     |                   |                   |   
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 Analyzing Burst Traffic  

You can use the Wireshark to analyze the burst traffic. The steps are as follows: 

1. Choose Statistics > IO Graphs to display the IO Graphs dialog box. 

2. Adjust the values of parameters in X Axis and Y Axis.In Graphs, the five columns 

indicate the modes of displaying the traffic figure according to five filtering conditions. 

You can select one or multiple modes.  

For example, set the filtering condition to udp in column 1 and click Graph1. The UDP 

traffic is displayed in black curve. Set the filtering condition to tcp in column 3 and click 

Graph3. The TCP traffic is displayed in green curve. 

Figure 5-38 Analysis on burst traffic 

 

 

 Multicast Traffic  

You can use the Wireshark to view the statistics on multicast flows among the captured 

packets, including the source address, source port, multicast address, multicast port, and 

average traffic. 

Operation procedure: Choose Statistics >  Multicast Streams, as shown in Figure 

5-39. 



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 5 Appendix 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

162 

 

Figure 5-39 Analysis on multicast traffic 

 

 

File Exporting 

You can use the Wireshark to export the packet analysis result to other file formats.  

For example, to display the hierarchical structure of a packet in a Word document, you can 

export the analysis result on the Packet Detail window to the text format. Then paste the 

contents to the Word document.  

The Wireshark can export packets in the following formats: 

 Plain text: The document can contain the contents of the Packet List, Packet Details, or 

Packet Bytes window, which are analyzed by the Wireshark. 

 Comma Separated Values Summary (CSV): The document contains only the summary of 

packets on the Packet List window, without the hierarchical structure of packets and 

packet contents in hexadecimal notation on the Packet Details window. 

 The documents in XML Packet Summary (PSML) and XML Packet Detail (PDML) 

formats are documents in .xml format. Their difference is as follows: 

− The document in PSML format contains the contents on the Packet List window of 

the Wireshark, that is, summary of packets. 

− The document in PDML format contains the contents on the Packet Detail window 

of the Wireshark, that is, details on packets. 

The file can be exported in two ways, which are described as follows. 

 Exporting Files Through Export  

The steps are as follows: 

1. Choose Export >  File to display the Export File dialog box, as shown in Figure 5-40. 
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Figure 5-40 Export File dialog box 

 

 

2. Select the format of saving files (.txt, .ps, .CSV, PSML, PDML) in Save as type. 

3. Enter the file name to be saved. 

4. Select the output packet range in Packet Range. 

5. Select the output packet format in Packet Format. 

 

 

When entering the file name to be saved, you must add the extension name. This is because 

the Wireshark does not add the extension name when exporting files. If the file in Plain text 

format is exported, you must add the extension name .txt. If the file in Post Script format is 

exported, you must add the extension name .ps. If the file in CSV format is exported, you 

must add the extension name .csv. If the file in PSML or PDML format is exported, you must 

add the extension name .xml. This is because the extension name PSML or PDML cannot be 

recognized. 

 Exporting Files Through Print  

Exporting files through Print is similar to exporting files through Export, but there is a 

slight difference. The steps are as follows: 

1. Choose File > Print to display the Print dialog box, as shown in Figure 5-41.  



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 5 Appendix 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

164 

 

Figure 5-41 Print dialog box 

 

 

2. Select the output packet format in Printer. 

3. Select Output to file and enter the file name to be saved in the text box. Adjust the 

extension name according to the actual situation. 

4. The settings in Packet Range and Packet Format are the same as those in Exporting 

Files Through Export. 

 

 

You can only export files in Plain text or Post Script format through this method. 

5.8 XML Files Supported by the XML Browser 

The XML browser supports seven types of XML files. This section describes the parameters 

in the files. 

5.8.1 TextMenu 

Figure 5-42 shows the page of the TextMenu type, which displays menu items in text. 
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Figure 5-42 Page of the TextMenu type 

 

 

An example of the XML file of the TextMenu type is as follows: 

<****TextMenu   

defaultIndex = "some integer"  

style = "numbered/none/radio"  

Beep = "yes/no"  

Timeout = "some integer"  

LockIn = "yes/no"  

WrapList = "yes/no"  

>  

<Title wrap = "yes/no">Menu Title</Title>  

<MenuItem>  

     <Prompt>First Choice</Prompt>  

     <URI>http://somepage.xml</URI>  

     <Dial>Number to dial</Dial>  

     <Selection>Selection</Selection>  

</MenuItem>  

<SoftKey index = "1-6">  

     <Label>TextLabel</Label>  

     <URI>http://someserver/somepage OR SoftKey:someaction</URI>  

</SoftKey>  

</****TextMenu >  

 

Table 5-2 lists the parameters in the XML file of the TextMenu type. 

Table 5-2 Parameters in the XML file of the TextMenu type 

Parameter Mandatory Value Type Description 

****TextMenu Yes The string **** 

can be any value, 

including a blank 

character string. 

Root element. 

defaultIndex No Integer Default index for accessing the 

menu page. 
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Parameter Mandatory Value Type Description 

Default value: 1 

style No numbered 

none 

radio 

Style of the icon to the left of a 

menu. 

 numbered: number icon. 

 none: no icon. 

 radio: radio icon. 

Beep No yes 

no 

Indicates whether the IP phone 

plays a beep tone when accessing 

the menu. 

Default value: no 

Timeout No Integer 

Unit: second 

Timeout interval. If a user does 

not perform any operations within 

the interval, the IP phone returns 

to the standby page.  

Default value: 45 

LockIn No yes 

no 

If the parameter is set to yes, the 

IP phone responds only to the 

defined soft keys. For example, 

when a user picks up the IP 

phone, the dialing page is not 

displayed. If the Dial menu item 

is set to a value, a user can make 

a call after picking up the phone. 

Default value: no 

WrapList No yes 

no 

Indicates whether to display the 

menu item specified by Prompt 

in multiple lines if the menu item 

is too long. 

Default value: no 

Title Yes Character string Title on the menu page. 

wrap No yes 

no 

Indicates whether to display the 

title in multiple lines if the title is 

too long. 

Default value: no 

MenuItem Yes None Menu item. 

A maximum of 30 menu items 

can be set. 

Prompt Yes Character string Menu item title, which is 

controlled by wrapList. 

URI Yes URI Operation corresponding to the 

menu item. 

Dial No Phone number When this menu item is selected, 
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Parameter Mandatory Value Type Description 

the IP phone makes a call to the 

phone number if a user picks up 

the phone, presses the account 

key, or presses the handsfree key.  

Selection No Character string If the URI of a soft key is an 

HTTP address, the IP phone 

suffixes ?selection=Preset 

parameter to the HTTP address. 

SoftKey No XML object For details, see 5.7.8 Soft Keys. 

 

Table 5-3 lists the default soft keys if no soft keys are defined in the XML file of the 

TextMenu type. 

Table 5-3 Default soft keys on the page of the TextMenu type 

Soft Key Index Name URI 

1 Exit SoftKey:Exit 

4 Select SoftKey:Select 

 

Table 5-4 lists the functions of keys on the page of the TextMenu type. 

Table 5-4 Functions of keys on the page of the TextMenu type 

Key Name Key Function 

UP/DOWN Up and down 

arrow keys 

Moves the cursor up or down. 

Digitkey Number keys 1 

to 9 

Moves the cursor to the menu item indicated by the 

same number. If the number key that a user presses is 

larger than the number of menu items, the IP phone 

moves the cursor to the last menu item. 

Select Soft key. 

URI="SoftKey:S

elect" 

Invokes a command (for example, the http or Dial 

command) to access the URI in the menu item. 

Exit Soft key. 

URI="SoftKey:E

xit" 

Displays the previous XML page. If the current page is 

the first page that a user views, the IP phone displays the 

standby page. 

OffHook/Li

nekey/Hand

free 

Off-hook/Accou

nt key/Handsfree 

key 

If the Dial menu item is not blank, the IP phone makes a 

call to the number specified by the Dial menu item. If 

the menu item is blank and the value of LockIn is yes, 

the IP phone does not respond to the keys; if the menu 

item is blank and the value of LockIn is no, the IP 

phone displays the dialing page. 
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Key Name Key Function 

Cancel X key on an IP 

phone 

Returns to the standby page. 

Ok OK key on an IP 

phone 

If the value of LockIn is no, the OK key functions as the 

Select key; if the value of LockIn is yes, the IP phone 

does not respond to this key. 

DSS key 

except the 

key 

assigned the 

SIP account 

function 

DSS key, 

including keys 

on expansion 

modules 

If the value of LockIn is no, the IP phone performs the 

function specified by the DSS key; if the value of 

LockIn is yes, the IP phone does not respond to this 

key. 

 

An example is as follows: 

5.8.2 TextScreen 

Figure 5-43 shows the page of the TextScreen type, which displays a text note. 

Figure 5-43 Page of the TextScreen type 

 

 

An example of the XML file of the TextScreen type is as follows: 

<****TextScreen  

doneAction = "some URI"  

Beep = "yes/no"  

Timeout = "some integer"  

LockIn = "yes/no"  

>  

<Title wrap = "yes/no">Screen Title</Title>  

<Text>The screen text goes here</Text>  

</****TextScreen>  

 

Table 5-5 lists the parameters in the XML file of the TextScreen type. 
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Table 5-5 Parameters in the XML file of the TextScreen type 

Parameter Mandatory Value Type Description 

****TextSc

reen 

Yes The string **** 

can be any 

value, including 

a blank 

character string. 

Root element. 

Beep No yes 

no 

Indicates whether the IP phone plays a 

beep tone when accessing the menu. 

Default value: no 

doneAction No URI URI that an IP phone accesses when a 

user presses the done soft key. 

Timeout No Integer 

Unit: second 

Timeout interval. If a user does not 

perform any operations within the 

interval, the IP phone returns to the 

standby page. 

Default value: 45 

LockIn No yes 

no 

If the parameter is set to yes, the IP 

phone responds only to the defined soft 

keys. For example, when a user picks up 

the IP phone, the dialing page is not 

displayed. 

Default value: no 

Title Yes Character string Title of the text note. 

Wrap No yes 

no 

Indicates whether to display the title in 

multiple lines if the title is too long. 

Default value: yes 

Text Yes Character string Title of the text note. 

SoftKey No XML object For details, see 5.3.8 Soft Keys. 

 

Table 5-6 lists the default soft key if no soft keys are defined in the XML file of the 

TextScreen type. 

Table 5-6 Default soft key on the page of the TextScreen type 

Soft Key Index Name URI 

1 Exit SoftKey:Exit 

 

Table 5-7 lists the functions of keys on the page of the TextScreen type. 
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Table 5-7 Functions of keys on the page of the TextScreen type 

Key Name Key Function 

UP/DOWN Up and down 

arrow keys 

Scrolls through the text. 

Digitkey Number keys 1 

to 9 

The IP phone has no response when users press number 

keys. 

Exit Soft key. 

URI="SoftKey:E

xit" 

Displays the previous XML page. If the current page is 

the first page that a user views, the IP phone displays the 

standby page.  

OffHook/Li

nekey 

/Handfree/D

SSkey 

Off-hook/Accou

nt key/Handsfree 

key/DSS key 

If the value of LockIn is no, the IP phone displays the 

dialing page or performs the function specified by the 

DSS key; if the value of LockIn is yes, the IP phone 

does not respond to the keys. 

Cancel X key on an IP 

phone 

Returns to the standby page. 

Ok OK key on an IP 

phone 

Accesses the URI specified by doneAction. 

 

An example is as follows: 

5.8.3 InputScreen 

Figure 5-44 shows the page of the InputScreen type, which asks a user to enter information 

and sends the information to the server. 

Figure 5-44 Page of the InputScreen type 

 

 

An example of the XML file of the InputScreen type is as follows: 

<****InputScreen  

type = "IP/string/number/timeUS/timeInt/dateUS/dateInt"  



Huawei IP Phone eSpace 

7810&7820&7830&7850&7870&7803X 

Administrator Guide 5 Appendix 

 

Issue 01 (2011-12-31) Huawei Proprietary and Confidential                   

Copyright © Huawei Technologies Co., Ltd. 

171 

 

password = "yes/no"  

editable = "yes/no"  

Beep = "yes/no"  

Timeout = "some integer"  

LockIn = "yes/no"  

defaultIndex = "some integer 1 to 6"  

displayMode = "normal/condensed"  

inputLanguage = "English/French/German/Italian/Spanish"   

>  

<Title wrap = "yes/no">Title string</Title>  

<Prompt>Guidance for the input</Prompt>  

<URL>Target receiving the input</URL>  

<Parameter>name of the parameter add to URL</Parameter>  

<Default>Default Value (1)</Default>  

<InputField   

type = "IP/string/number/timeUS/timeInt/dateUS/dateInt/empty"  

password = "yes/no"  

editable = "yes/no"  

>  

<Prompt>Guidance for the input</Prompt>  

<URL>Target receiving the input</URL>  

<Parameter>parameter name add to URL</Parameter>  

<Default>Default Value</Default>  

<Selection>Selection</Selection>  

</InputField>  

</****InputScreen>  

 

Table 5-8 lists the parameters in the XML file of the InputScreen type. 

Table 5-8 Parameters in the XML file of the InputScreen type 

Parameter Mandatory Value Type Description 

****InputScree

n 

Yes The string 

**** can be 

any value, 

including a 

blank 

character 

string. 

Root element. 

Type Yes IP 

string 

number 

timeUS 

timeInt 

dateUS 

dateInt 

empty 

Data type.  

 IP: IP address 

 string: character string 

 number 

 timeUS: time in 12-hour format. 

AM indicates a time in the 

morning, and PM indicates a time 

in the afternoon. 

 timeInt: time in 24-hour format 

 dateUS: date in the format 

MM/DD/YYYY 

 dateInt: date in the format 
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Parameter Mandatory Value Type Description 

DD/MM/YYYY 

 empty: blank lines. The number of 

lines is specified by displayMode.  

Default value: string (Currently, only 

the value string is supported.) 

Beep No yes 

no 

Indicates whether the IP phone plays a 

beep tone when accessing the menu. 

Default value: no 

Password No yes 

no 

An asterisk (*) is displayed when a 

user enters a character. 

Default value: no 

Timeout No Integer 

Unit: second 

Timeout interval. If a user does not 

perform any operations within the 

interval, the IP phone returns to the 

standby page. 

Default value: 45 

LockIn No yes 

no 

If the parameter is set to yes, the IP 

phone responds only to the defined soft 

keys after the page of the InputScreen 

type is displayed. For example, when a 

user picks up the IP phone, the dialing 

page is not displayed.  

Default value: no 

inputLanguage No English 

French 

German 

Italian 

Spanish 

Language of the content that a user 

enters. 

Default value: English 

displayMode No normal 

condensed 

 Normal: indicates that the field and 

text box are displayed in two lines. 

 Condensed: indicates that the field 

and text box are displayed in one 

line. 

Default value: Normal 

defaultIndex No Integer Default text box index if multiple text 

boxes exist.  

Default value: 1 

Title Yes Character 

string 

Title of the entered object. 

Wrap No yes 

no 

Indicates whether to display the title in 

multiple lines if the title is too long. 

Default value: yes 
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Parameter Mandatory Value Type Description 

Prompt No Character 

string 

Prompt information entered by a user. 

URL Yes URL URL to which the IP phone sends the 

information entered by a user. 

Parameter Yes Character 

string 

Name of the parameter that the IP 

phone suffixes to an URI. The new 

URI is in the format old 

URI?Parameter=information entered 

by a user. 

Default No Character 

string 

Information that is entered by default. 

InputField No None. A maximum of six text boxes can be 

set. 

Type No IP 

string 

number 

timeUS 

timeInt 

dateUS 

dateInt 

empty 

Data type.  

 IP: IP address 

 string: character string 

 number 

 timeUS: time in 12-hour format. 

AM indicates a time in the 

morning, and PM indicates a time 

in the afternoon. 

 timeInt: time in 24-hour format 

 dateUS: date in the format 

MM/DD/YYYY 

 dateInt: date in the format 

DD/MM/YYYY 

 empty: blank lines. The number of 

lines is specified by displayMode. 

Currently, only the value string is 

supported. 

password No yes 

no 

An asterisk (*) is displayed when a 

user enters a character. 

Default value: no 

editable No yes 

no 

Indicates whether a user can enter 

information. The value no indicates 

that a user cannot enter information or 

modify the default information. 

Default value: yes 

Prompt No Character 

string 

Prompt information entered by a user. 

Default No Character 

string 

Information that is entered by default. 
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Parameter Mandatory Value Type Description 

Selection No Character 

string 

If the URI of a soft key is an HTTP 

address, the IP phone 

suffixes ?selection=Preset parameter 

to the HTTP address.  

Example: 

http://10.1.0.105/input.php?selection=1 

Softkey No XML object Soft key to be added, for example, the 

soft key for adding input methods. A 

maximum of six soft keys are added. 

SoftKey No XML object For details, see 5.7.8 Soft Keys. 

 

Table 5-9 lists the formats of the timeUS, timeInt, dateUS, and dateInt types. 

Table 5-9 Description of the timeUS, timeInt, dateUS, and dateInt types  

Type Format Example 

timeUS HH:MM:SS AM/PM 

HH: 1 to 12, MM: 0 to 59, SS: 0 to 59 

02:00:23 AM 

12:59:00 PM 

timeInt HH:MM:SS 

HH: 0 to 23, MM: 0 to 59, SS: 0 to 59 

23:25:00 

dateUS MM/DD/YYYY 

MM: 1 to 12, DD: 1 to 31, YYYY: 0000 to 

9999 

12/31/2009 

dateInt MM/DD/YYYY 

MM: 1 to 12, DD: 1 to 31, YYYY: 0000 to 

9999 

31/01/2010 

 

Table 5-10 lists the default soft keys that are used when no soft keys are set and Type is set to 

IP in the XML file of the InputScreen type. 

Table 5-10 Default soft keys when Type is set to IP 

Soft Key Index Name URI 

1 Exit SoftKey:Exit 

2 Dot SoftKey:Dot 

3 Backspace SoftKey: BackSpace 

4 Submit SoftKey: Submit 
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Table 5-11 lists the default soft keys that are used when no soft keys are set and Type is set to 

Number in the XML file of the InputScreen type. 

Table 5-11 Default soft keys when Type is set to Number 

Soft Key Index Name URI 

1 Exit SoftKey:Exit 

3 Backspace SoftKey: BackSpace 

4 Submit SoftKey: Submit 

 

An example is as follows: 

5.8.4 Directory 

Figure 5-45 shows the page of the Directory type, which is used for downloading phone 

books from the server and displays phone books on the LCD. 

Figure 5-45 Page of the Directory type 

 

 

An example of the XML file of the Directory type is as follows: 

<****Directory  

Next = "some URI"  

Previous = "some URI"  

Beep = "yes/no"  

Timeout = "some integer"  

LockIn = "yes/no"  

>  

<Title wrap = "yes/no">Directory Title</Title>  

<MenuItem>  

     <Prompt>Contact Name</Prompt>  

     <URI>number</URI>  

</MenuItem>  
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</****Directory>  

 

Table 5-12 lists the parameters in the XML file of the Directory type. 

Table 5-12 Parameters in the XML file of the Directory file 

Parameter Mandatory 
Value 
Type Description 

****Directory Yes None. Root element. 

Next No URI URI corresponding to the Next soft key. 

Previous No URI URI corresponding to the Previous soft 

key. 

Beep No yes 

no 

Indicates whether the IP phone plays a 

beep tone when accessing the menu. 

Default value: no 

Timeout No Integer 

Unit: 

second 

Timeout interval. If a user does not 

perform any operations within the 

interval, the IP phone returns to the 

standby page. 

Default value: 45 

LockIn No yes 

no 

If the parameter is set to yes, the IP phone 

responds only to the defined soft keys. For 

example, when a user picks up the IP 

phone, the dialing page is not displayed.  

Default value: no 

Title Yes Character 

string 

Title of an phone book. 

Wrap No yes 

no 

Indicates whether to display the title in 

multiple lines if the title is too long.  

Default value: yes 

MenuItem Yes None Address book at a lower level. 

A maximum of 15 address books can be 

added.  

Prompt Yes Character 

string 

Title of an address book. 

URI Yes URI Operation on an item in an address book. 

For example, the IP phone dials a phone 

number. 

Softkey No xml object For details, see 5.7.8 Soft Keys. 

 

Table 5-13 lists the default soft keys if no soft keys are defined in the XML file of the 

Directory type. 
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Table 5-13 Default soft keys on the page of the Directory type 

Soft Key Index Name URI 

1 Exit SoftKey: Exit 

2 Previous SoftKey: Previous 

3 Next SoftKey: Next 

4 Call SoftKey: Dial 

 

Table 5-14 lists the functions of keys on the page of the Directory type. 

Table 5-14 Functions of keys on the page of the Directory type 

Key Name Key Function 

UP/DOWN Up and down 

arrow keys 

Moves the cursor up or down.  

Digitkey Number keys 1 

to 9 

Moves the cursor to the menu item indicated by the 

same number. If the number key that a user presses 

is larger than the number of menu items, the IP 

phone moves the cursor to the last menu item.  

Dial Soft key. 

URI="SoftKey:

Dial" 

Calls the number in the selected address book. 

Previous Soft key. 

URI="SoftKey:

Previous" 

Accesses the URI (such as an HTTP address) 

specified by Previous. 

Next Soft key. 

URI="SoftKey:

Next" 

Accesses the URI (such as an HTTP address) 

specified by Next. 

Exit Soft key. 

URI="SoftKey:

Exit" 

Displays the previous page. 

OffHook/Lineke

y/Handfree 

Off-hook/Acco

unt 

key/Handsfree 

key 

Calls the number in the selected address book. 

Cancel X key on an IP 

phone 

Returns to the standby page. 

Ok OK key on an 

IP phone 

If the value of LockIn is no, the OK key functions 

as the Dial key; if the value of LockIn is yes, the IP 

phone does not respond to this key. 

DSS key except 

the key assigned 

DSS key, 

including keys 

If the value of LockIn is no, the IP phone performs 

the function specified by the DSS key; if the value of 
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Key Name Key Function 

the SIP account 

function 

on expansion 

modules 

LockIn is yes, the IP phone does not respond to this 

key.  

 

An example is as follows: 

5.8.5 Execute 

The page of the Execute type is used to request an IP phone to run commands in a specified 

sequence. When the IP phone runs the command, no prompt message is displayed. 

An example of the XML file of the Execute type is as follows: 

<****Execute Beep = "yes/no">  

<ExecuteItem URI = "URI"/>  

</****Execute>  

 

Table 5-15 lists the parameters in the XML file of the Execute type. 

Table 5-15 Parameters in the XML file of the Execute type 

Parameter Mandatory Value Type Description 

****Execute Yes The string **** 

can be any value, 

including a blank 

character string. 

Root element. 

Beep No yes 

no 

Indicates whether to play a beep tone 

when the IP phone starts to run 

commands. 

Default value: no 

ExecuteItem Yes None. Command item. A maximum of 30 

commands can be added. 

URI No URI Operation corresponding to a 

command, for example, calling a user 

or downloading data from the server 

based on the URI. 

 

Table 5-16 lists the common commands that are configured in the XML file of the Execute 

type. 

Table 5-16 Common commands that are configured in the XML file of the Execute type 

Name URI Function 

Any Supported uri http(s)://myserver.com/myscript.pl Accesses the URI. 

Dial:XXXXX Calls the phone number. 
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Name URI Function 

Led:XXXX=on/off/slowflash/fastfl

ash 

Controls the indicator. 

Key:XXXX Presses the keys XXXX. 

Wav.Play:[tftp|http://[username[:pa

ssword]@] 

<host>[:port][/<Path>]/<file> 

Wav.Stop: 

Plays or stops a WAV file. 

Phone Reboot Command:Reset Restores factory settings. 

Phone Fast Reboot Command:Reboot Restarts the IP phone. 

Phone Lock Command:Lock Enables the talk only function. 

Phone Unlock Command:Unlock Unlocks all keys.  

Clear Command:ClearCallersList Clears the local call history. 

Command:ClearDirectory Clears the local contact list. 

Command:ClearRedialList Clears the call history. 

Do nothing None. None. 

 

Table 5-17 lists the settings of XXXX in the URI Led:XXXX=on/off/slowflash/fastflash. 

Table 5-17 Settings of XXXX in the URI Led:XXXX=on/off/slowflash/fastflash 

Setting Indicator Example 

EXP-%d-%d2-%s %d: %dth expansion module. The 

value ranges from 1 to 6. 

%d2: %d2th key on an expansion 

module. The value ranges from 1 

to 20. 

%s: color of the indicator. The 

value is RED or GREEN. 

Led:EXP38-2-3-RED=on: 

indicates that the indicator 

corresponding to the third key on 

the second expansion module is 

turned on in red. 

LINE%d %d: number of the indicator 

corresponding to a line key. The 

value ranges from 1 to 6. 

Led:LINE3=on: indicates that 

the indicator corresponding to 

the line3 key is turned on. 

MEMO%d_%s %d: number of the DSS key. The 

value ranges from 1 to 10.  

%s: color of the indicator. The 

value is RED or GREEN. 

Led: MEMO5_GREEN =on: 

indicates that the indicator 

corresponding to DSS key 5 is 

turned on in green. 

HEADSET Headset status indicator. Led:HEADSET=off: indicates 

that the headset status indicator 

is turned off. 
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Setting Indicator Example 

BACKLIGHT Backlight. N/A 

HANDFREE Handsfree status indicator. N/A 

POWER Power supply indicator. N/A 

 

Table 5-18 lists the settings of XXXX in the URI Key:XXXX. 

Table 5-18 Settings of XXXX in the URI Key:XXXX 

Setting Key 

EXP-%d-%d %d: %dth expansion module. The value ranges from 1 to 6. 

%d2: %d2th key on an expansion module. The value ranges from 1 to 

20. An example is as follows: 

Key:EXP-2-3: indicates that the third key on the second expansion 

module. 

OFF_HOOK Off-hook key 

Example: Key:OFF_HOOK 

ON_HOOK On-hook 

OK OK key 

CANCEL X key 

UP Up arrow key 

DOWN Down arrow key 

LEFT Left arrow key 

RIGHT Right arrow key 

INCREASE Key for increasing the volume 

DECREASE Key for decreasing the volume 

REDIAL Redial key 

HOLD Hold key 

MUTE Mute key 

CONFERENCE Conference key  

TRANSFER Transfer key 

FWD Forward key 

PHONEBOOK Key for accessing a remote address book 

SWITCH Switch key 

HEADSET Headset key 
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Setting Key 

HANDFREE Handsfree key 

LINE%d Account keys. The value of %d ranges from 1 to 6. 

HOTKEY%d Soft keys. The value of %d ranges from 1 to 4. 

MEMORY%d Memory keys. The value of %d ranges from 1 to 10. 

KEY_%d Number keys. The value of %d ranges from 0 to 9. 

STAR Star key (*) 

POUND Pound key (#) 

GROUP_LISTEN Group listening key. 

HOLD_PUBLIC Public Hold key when the SCA function is enabled. 

HOLD_PRIVATE Private Hold key when the SCA function is enabled. 

 

An example is as follows: 

5.8.6 Status 

Figure 5-46 shows the page of the Status type, which displays the IP phone's state. 

Figure 5-46 Page of the Status type. 

 

 

An example of the XML file of the Status type is as follows: 

<****Status Beep = "yes/no">  

<Session>Session ID</Session>  

<Message  

    Index = "index"  

    Type = "alert"  

    Timeout = "timeout"  

>Message</Message>  

</****Status>  

 

Table 5-19 lists the parameters in the XML file of the Status type. 
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Table 5-19 Parameters in the XML file of the Status type 

Parameter Mandatory Value Type Description 

****Status Yes The string **** 

can be any 

value, including 

a blank 

character string. 

Root element. 

Beep No yes 

no 

Indicates whether to play a beep tone 

when displays status information. 

Default value: no 

Session No Character string Session ID, identifying different display 

objects. 

The minimum value is 0. 

Message Yes None. Information displayed on the LCD. 

The value ranges from 0 to 10. 

Index Yes Integer Index of status information in a session. 

The value ranges from 1 to 10. 

Default value: 1 

Type No alert Currently only the value alert is 

supported. If no type is specified, status 

information is always displayed in turn 

on the LCD until a user presses a key or 

the IP phone exits the page as required.  

Default value: alert 

Timeout No Integer 

Unit: second 

Timeout interval for displaying status 

information. 

Default value: 3 

Softkey No XML object For details, see 5.7.8 Soft Keys. 

 

Table 5-20 lists the functions of keys on the page of the Status type. 

Table 5-20 Functions of keys on the page of the Status type 

Key Name Key Function 

UP/DOWN Up and down 

arrow keys 

Moves the cursor up or down. 

Digitkey Number keys 1 

to 9 

Moves the cursor to the message item indicated by the 

same number. If the number key that a user presses is 

larger than the number of message items, the IP phone 

moves the cursor to the last message item.  

Exit Soft key. 

URI="SoftKey:E

Displays the previous XML page. If the current page is 

the first page that a user views, the IP phone displays the 
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Key Name Key Function 

xit" standby page.  

OffHook/Li

nekey/Hand

free/DSSke

y 

Off-hook/Accou

nt key/Handsfree 

key/DSSkey 

If the value of LockIn is no, the IP phone displays the 

dialing page or performs the function specified by the 

DSS key; if the value of LockIn is yes, the IP phone 

does not respond to the keys. 

Cancel X key on an IP 

phone 

Returns to the standby page. 

Ok OK key on an IP 

phone 

Accesses the URI specified by doneAction. 

 

An example is as follows: 

5.8.7 Configuration 

The XML file of the Configuration type is used for modifying IP phone settings. No page is 

displayed on the LCD for this file. 

An example of the XML file of the Configuration type is as follows: 

<****Configuration  

Beep = "yes/no"  

setType = "config/boot"  

>  

<ConfigurationItem>  

     <Path>path</Path>  

     <Session>session</Session>  

<Parameter>parameter</Parameter>  

<Value>value</Value>  

</ConfigurationItem>  

</****Configuration>  

 

Table 5-21 lists the parameters in the XML file of the Configuration type. 

Table 5-21 Parameters in the XML file of the Configuration type 

Parameter Mandatory Value Type Description 

****Config

uration 

Yes The string **** 

can be any 

value, including 

a blank character 

string. 

Root element for setting IP phone 

parameters. 

Beep No yes 

no 

Indicates whether to play a beep tone 

when a user sets IP phone parameters. 

Default value: no 

setType No config 

boot 

 config: indicates that the 

modification takes effect, and the IP 
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Parameter Mandatory Value Type Description 

phone does not restart. 

 boot: indicates that the modification 

takes effect, and the IP phone 

restarts. 

Configurati

onItem 

Yes None. Configuration item. The value ranges 

from 0 to 1000. 

Path  Yes Character string Path where parameters are stored. 

Session Yes Character string Node where parameters are stored. 

Parameter Yes Character string Parameter name. 

Value Yes Character string Parameter value. 

 

An example is as follows: 

5.8.8 Soft Keys 

A user can define four soft keys on an IP phone. The format of the file for configuring soft 

keys is as follows: 

<SoftKey index = "1-6">  

<Label>Text</Label>  

<URI>http://someserver/somepage OR SoftKey:someaction</URI>  

</SoftKey>  

 

Table 5-22 lists parameters for configuring soft keys. 

Table 5-22 Parameters for configuring soft keys 

Parameter Mandatory Value Type Description 

SoftKey Yes None. Root element for configuring a soft key. 

index Yes Integer Index value of the soft key. The values 

for soft keys from left to right are 1 to 4. 

If more than four soft keys are 

configured, the fourth soft key is 

automatically changed to More for 

displaying the next page of keys. 

The value ranges from 1 to 6. 

Label Yes Character string Name of the soft key. 

URI Yes Character string Operation corresponding to the soft key. 

 

Table 5-23 lists available soft keys. 
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Table 5-23 Available soft keys 

Key Value Description 

Exit Displays the previous page. 

Dial Calls the selected phone number. 

Submit Submits information. 

Select Displays the selected item. 

Next Displays the next page. 

Previous Displays the previous page. 

Dot Enters a dot. 

BackSpace Deletes the character to the left of the cursor. 

ChangeMode Switches the input methods. 

 


